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CADSTAR Express 자습서 

교육을 목적으로 하는 Projects 가 제공된다. 

 

 

 

 

 

이 교재는 CADSTAR Express 자습서로 캐드스타를 이용한 PCB 디자인 설계 흐름을 혼자서도 쉽게 파악할 수 

있도록 만들어 졌다. 이 교재는 ㈜디엠에스에스 홈페이지 http://www.dmsscadstar.co.kr 에서 제공한다. 

 

이 교재와 함께 CADSTAR Express 를 무상으로 공급받을 수 있다. CADSTAR Express는 CADSTAR Full 

Version의 많은 기능이 제공되며, 오직 부품 수 (최대 50 개) 와 Pad 수 ( 최대 300 핀 ) 만 제한된다. 

 

CADSTAR Express를 설치하는 방법은 실행파일을 더블클릭하고 간단하게 지시에 따르면 된다. 

 

이 교재는 샘플 회로도 도면을 보여주고 이것을 캐드스타를 이용해 Schematic Design 으로 그린 후 Error 없이 

PCB Design 으로 전환하여 배치와 배선 작업을 완료하는 형식으로 되어 있다. 두 번째 단계는 Library 를 

어떻게 생성하고 등록하는지 설명한다. 

 

이 자습서를 따라 하면 캐드스타를 짧은 시간 내에 배울 수 있다. 

 

캐드스타를 이용해 회로도와 PCB Design 을 누구나 쉽게 작업할 수 있다. 각각의 단계를 간단히 설명해 

놓았으며 설명된 내용이 정확히 이해되지 않는다면 카메라 아이콘을 클릭하여 동영상으로 각 단계를 볼 수 

있다. (이 동영상을 보기 위해서는 인터넷 연결이 필요하다.) 

 

Link된 동영상은 DEMO를 목적으로 한다. 교재의 실습과정과 정확하게 일치하지 않을 수 있다. 교재 실습 과정을 

따른다. 

 

이 교재에는 각 과정을 작업하면서 특정 파일 이름으로 저장하는 과정이 있다. 만약, 과정을 마치지 않고 다음 

단계로 가고 싶은 경우를 위해 편하게 Back-up파일을 제공한다. 파일 이름이 “_CS”로 끝나는 파일을 열러 File -

> Save As를 이용하여 저장하여 사용한다. 

 

이 교재의 정보는 인쇄하는 시점에서 정확하며 사전에 예고 없이 변경될 수 있다. 

이 교재는 ZUKEN 사와 ㈜ 디엠에스에스의 서면승인 없이 어떤 부분도 복제하여 사용할 수 없다. 

캐드스타는 ZUKEN 사의 등록 상표이다.  

이 교재는 무료로 주어지고 판매되지 않는다. 
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●  교재내용: 

 

캐드스타 소개 

기본 디자인 흐름 

 시작 

 기본 작업 과장 

 사용자 인터페이스 

 Stroke 

제 1 장 - Design A 

Step 1 - Design A 의 회로도 

Step 2 - Design A 의 PCB 배치 

Step 3 - Design A 의 PCB 배선 

Step 4 - Design A 의 생산에 필요한 Data 

Step 5 – 차 후 다시 사용하기 위한 Design 의 저장 

 3D 

 제 2 장 - Design B 

Step 1 - Design B 의 회로도 

Step 2 - Design B 의 PCB 배치 

Step 3 - Design B 의 PCB 배선 

Step 4 - Design B 의 생산에 필요한 Data 

 제 3 장 - Library 

Step 1 – PCB Component / BGA 마법사 

Step 2 – Schematic Symbol / Block 마법사 

Step 3 – Parts Library Editor 

 CADSTAR FPGA 

 제 4 장 - Design C (P.R.Editor XR 2000 을 이용하는 고급 사용자) 

Step 1 - Design C 의 회로도 

Step 2 - Design C 의 PCB 배치 

Step 3 - Design C 의 PCB 배선 

Step 4 - Design C 의 생산에 필요한 Data 

 제 5 장 - Design D (단면 보드 설계) 

Step 1 - Design D 의 회로도 

Step 2 - Design D 의 PCB 배치 

Step 3 – Design D 의 PCB 배선 (배선도중 Jumper 추가) 

Step 4 - Design D 의 생산에 필요한 Data 

결론 

 

이 자습서는 윈도우7 환경을 사용하여 개정되었다. 소프트웨어는 저자의 컴퓨터에 CADSTAR Express 16 

SETUP 프로그램의 각각의 선택과 기본 위치를 사용하여 설치하였다. CADSTAR Express 16은 윈도8.1을 

지원한다.
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●  캐드스타 소개 

 

캐드스타는 EDA 전문 설계 소프트웨어로 Schematic Design 작업 후 그것을 PCB로 에러 없이 쉽게 전환한다. 

PCB Design 으로 전환된 부품 정보를 기판의 내부에 배치할 수 있도록 한다. 

 

배치와 배선은 PCB 설계에서 아주 중요한 부분이다. 캐드스타는 Embedded Place & Route Editor 또는 좀 더 

고급의 기능이 제공되는 Place & Route Editor 모두에서 Push-a-side 배치와 배선 (수동, 자동배선 및 반 자동) 

기능들을 제공하여 필요한 곳에서 편리하게 배선할 수 있다. Embedded Place & Route Editor 는 간단한 PCB 

설계나 PCB 설계를 그리 많이 하지 않는 일반 사용자를 위해 개발 되었고 Place & Route Editor 는 좀 더 

강력한 기능을 필요로 하는 사용자를 위해 제공된다. 추가적으로 High-Speed 를 고려하여 설계 (lengthening, 

delay, impedance, cross-talk, overshoot, reflection등) 한다면 옵션을 추가 할 수 있다. 추가 옵션으로는 PCB 

설계를 3D 환경에서 검증하는 Board Modeler Lite 와 별도의 File 없이 ‘master’ 디자인의 variants (B.O.M 과 

assembly drawing 포함)를 생성하는 CADSTAR Variant Manager 가 있다. 

 

PCB Design 이 완성되면 PCB 제작을 위한 출력 파일을 생성한다. 
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●  시작하기 

  

이제 PC에 CADSTAR가 설치 되었고 시작할 준비가 되었다. 시작 -> 모든프로그램 -> CADSTAR Express 15.0 

에서 Design Editor 아이콘을 클릭하여 시작한다. CADSTAR가 시작되고 아래 그림과 같은 Start Page가 보여질 

것이다. 

 

 

 

이 Page 애는 아래의 내용들이 나타난다. 

 

z 최근 사용한 Workspace File 

z 최근 사용한 Design 

z Help 와 PDF File 

z CADSTAR의 최신 소식 

z CADSTAR 홈페이지와 On-Line Library 같은 On-Line Link 

 

CADSTAR는 Multi-Document Design 환경으로 운용된다. 같은 Design Editor 환경에서 회로도와 PCB 디자인을 

모두 사용한다. 
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●  기본적인 디자인의 흐름 

 

Library  필요한 모든 Parts 라이브러리 (Schematic symbol & PCB footprint)가 사용가능한지 

확인한다. 그러나 이 자습서에서는 모든 Parts을이 제공된다. CADSTAR Library 에 새로운 

Parts를 만들고 싶으면 제 3 장을 참고한다. 

 

참고 : CADSTAR Express 에 제공되는 Library 에는 이 자습서에 설명된 PCB 디자인에 

필요한 모든 Part 와 온라인상의 CADSTAR Library 의 일부만 포함되어 있다. (CADSTAR 

온라인 Library는 Maintenance 계약이 있어야 사용가능하다.)  

 

Zuken website 에서 20,000 여개의 Parts Library 를 무료로 다운받아 사용할 수 있다.  

 

추가적인 Library 는 Zuken on-line support website 에서 제공된다. 이러한 Parts 

라이브러리는 부품을 제조한 업체의 Part Number 를 포함한 모든 정보가 지정되어 있어 

다운받아서 바로 사용할 수 있다. 현재 250,000 개 이상의 Parts 가 제공되며 지속적으로 

업데이트 되고, 추가될 것이다. 제공되지 않는 라이브러리는 Graphical Library Editor 와 

마법사 기능을 이용해 사용자가 원하는 부품을 빠르고 쉽게 생성할 수 있다. 

 

인터넷 상의 CADSTAR Exchange Library 는 캐드스타 유지보수 계약자에 한해서 사용 

가능하다. 

 

Schematic  CADSTAR가 Back Annotation 기능을 지원하지만 PCB design 작업을 하기 전에 회로도로 

시작하는 것이 좋다. 

 

PCB (배치) 회로도로부터 전환된 부품 정보를 Board 내에 부품을 배치한다. 

  

PCB (Routing) 배치 완성 후 각 신호선을 수동 또는 자동으로 배선한다. 

  

출력 최종 단계로 작업자가 요구하는 거의 모든 형식의 출력을 제공한다. 캐드스타는 Extended 

Gerber (RS274X), Extended N.C.Drill (Excellon), Placement data, Bill Off Materials, 

IPC356-D test data, DXF 그리고 ODB++ 등과 같은 생산에 필요한 어떠한 형식의 Data 도 

출력할 수 있다. 
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●  사용자 인터페이스 

 

CADSTAR 는 매우 사용하기 쉽다. 사용자가 회로도 설계를 할때나 PCB 설계를 할때나 일관된 사용자 

인터페이스를 제공한다. 

 

다음의 기능이 제공된다 

  

z 리본 형식의 툴바는 필요에따라 드래그하고 고정시킬 수 있다. 

z 툴바 아이콘은 원하는대로 구성할 수 있다. 

z Customizable 툴바와 메뉴는 사용자가 만든 Reports와 Macro 를 추가할 수 있다. 

z 탭으로된 Document Window 를 지원한다. – 윈도우 7 과 MS Office 의 최신 버전의 기능을 

사용한다. 

z “Stroke” – 화면 이동과 확대, 축소의 대부분의 기능을 수행하는 command macros다 

z 마우스 가우데 버튼을 누러 전방위로 이동한다. 

z 윈도우 7과 같은 최신의 운영체제에서 작업을 할 때 CADSTAR의 화면상태를 바꿀 수 있는 

테마가 제공된다. 메뉴를 좀 더 간편하게 표현하는 Collapsible 메뉴 같은 것이다. 

z Active HTML reports – Active HTML report 들을 CADSTAR 의 다른 dockable 윈도우처럼 

어느곳에나 놓을 수 있다.  

 

 

z CADSTAR와 Place & Route Editor 에서 Strokes 

 

만약 Stroke 명령어에 익숙하지 않다면 다음을 참조 한다. 

 

아래의 표에 있는 ‘gestures’ 중에서 하나의 모양을 오른쪽 마우스 버튼을 이용하여 드래그 하여 원하는 

명령어를 수행한다. 

 

Gesture를 만드는 방법 

 

z 마우스를 이용하여 디자인 영역에 커서를 위치한다. 

z 오른쪽 마우스 버튼을 클릭하고 마우스를 이동하는 동안 누르고 있는다. 커서가 이동하는 

길이 흰색 선으로 화면에 나타난다. 

z 마우스 버튼을 놓는다. 

 

주의 : 커서가 그려지는 길의 모양은 매우 중요하다. 또한 커서가 이동하는 방향도 중요하다. 방향이 다르면 

다른 명령어를 수행 하게 된다. 
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●  제 1 장 - Design A 

 

 

 

트랜지스터 Audio Amp(50 mW) 

 

이번에 작업할 회로는 Transistor Audio Amplifier 이다. 

 

제 1단계 - Design A 의 회로도 

 

위의 그림과 같이 손으로 그린 회로도를 검토하여 시작한다. – 오디오 증폭기의 디자인. 그런다음 회로도에 

사용되는 부품을 확인한다. 

 

손으로 그린 회로도에서, 12개의 Parts를 찾을 수 있다.  

 

 Qty. per Part 

2  2N3053 NPN Transistor   1 x 470 Ohm Resistor (470E-MRS25-1%) 

1  2N2905A PNP Transistor   1 x 1.5 kOhm Resistor (1K5-MRS25-1%) 

2  1N4148 Diode    1 x 5.6 kOhm Resistor (5k6-MRS25-1%) 

2  3.3. Ohm Resistor (3E3-MRS25-1%) 1 x 47uF/10V Elec. Cap (47uF-10V-EC) 

1  22 Ohm Resistor (22E-MRS25-1%)  1 x 1000uF/50V Elec. Cap (1000uF-50V-EC) 

5  SOLDEREYE-1MM (for Input, Speaker and 9V supply) 

 

Power supply로 9V battery를 사용한다. 
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1. [File] -> New [Schematic Design]을 선택하고 Template중 하나인 Form A3-euro를 선택한다. 

 

     

 

Template를 선택하면 Attribute를 사용하여 정보를 입력하는 대화상자가 나타난다. 

 

2. 아래의 Attribute 

영역에 회사이름과 설계자 

이름을 지정한다.  

 

이들은 회로도 형식 심볼의 Title 

block에 나타난다. 나중에 

사용자 자신의 Attribute와 Sheet 

형식을 갖게 쉽게 customize 할 

수 있다. 

 

 

팁 : 검정바탕에서 작업하는걸 

좋아하지 않으면 다른 바탕색을 

선택할 수있다. 

 

 

 

3.       [OK]를 누른다.  
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주의 : 만약 많은 Sheet를 사용하는 큰 회로도 작업을 

하는 경우에는, Sheet별 이름 영역을 지정하여 사용할 

수있다. 위의 그림과 같이 Name Range By Sheet 버튼을 

클릭하면 다음의 대화상자가 나타난다. 

 

 

이름이 없는 새로운 회로도 디자인을 시작 한다. [File] -> 

Save As 메뉴를 선택하고 DesignA1.scm으로 지정한다. 

 

 

 

이제 캐드스타창 왼쪽의 Libraries 자동 숨김 패널을 이용하여 원하는 part와 symbol을 추가하기 시작한다. 
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주의 : Libraries, Designs, Shape Properties 등에 대한 자동 숨기기탭 메뉴를 이용하여 필요히면 자동으로 숨길 

수 있다. 창의 위쪽에 있는 자동 숨기기 아이콘을 간단히 클릭한다. 작업공간 메뉴에서 커서가 멀리 이동하면 

숨겨진 위치로 자동으로 밀어진다. 메뉴를 다시 표시 하려면 왼쪽에 있는 작업영역 탭으로 커서를 드래그 한다. 

 

팁 : 디자인에 Part/symbol (2N3053같은)을 추가 할 때, 사용자는 Symbol을 선택하고 마우스 오른쪽 버튼을 

눌러 빠른 메뉴에서 Link: On-line CADSTAR Datasheet를 볼 수 있다. Link는 인터넷(혹은 인트라넷)에 있는 

URL의 하이퍼링크 뿐만 아니라 PDF 파일이나 Word 문서 같은 것에도 링크할 수 있다. 캐드스타 Parts Library 

Editor에서 Parts에 더 많은 Link를 추가할 수 있다. 어떤 Link는 만료되어 무용지물이 되었을 수 있음을 주의 

한다. 

 

팁 : 고급 Library 검색 및 필터링을 하기위해 다음의 추가적인 방법중의 하나를 시도한다. 가능하다면 어떤 

alternate symbol을 사용할 것인지를 지정하는 방법은 양쪽 모두에서 사용된다. 

 

●   Library 탭에서 Library 

Searcher를 클릭하고 

Parts.lib를 선택한다. 

(또는 사용자가 

검색하고자 하는 다른 

어떤 Parts Libraries) 

 

 

 

 

 

 

 

 

 

 

 

 

●   [Symbol] -> Part or Symbol 

 

4. Add to Design 메뉴를 클릭하여 회로도에 두 

개의 2N3053 트랜지스터를 배치하거나 

Libraries 패널에서 트랜지스터를 드래그하여 

배치한다. 즉, 하일라이트 된 TO-92 

Componen에 대한 2N3053를 클릭하고 왼쪽 

마우스 버튼을 누른채로 릴리즈 없이 

Sheet로 드래그 한다. 
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핀에 나타나는 빨간 나비넥타이 표시는 신경쓰지 않아도 

된다. 이것은 연결이 안된 핀을 표시해 주는 것이다. 이 

표시는 핀에 Connection이 연결되면 자동으로 없어진다. 

 

드래그 하는 동안 mirror나 회전 하여 Symbol을 배치하기 

위해 마우스 오른쪽 버튼을 사용할 수 있다. ‘m’ 이나 ‘r’ 

핫키 혹은 회전을 위한 Function 키 <F3>을 사용한다. 

 

 

팁 : [File] 탭을 선택하고 바닥에 있는 Customize를 이용하여 Function 키를 지정할 수 있다. 

 

 

 

팁 : ‘?<엔터>’를 쳐서 핫키 명령어에대한 정보를 좀 더 알아볼 수 

있다. (이것은 캐드스타창 왼쪽 아래부분의 명령어 줄에 나타날 

것이다.)  

 

5. 다른 11개의 Parts도 같은 방법으로 작업한다. (사용자는 Through-hole 이나 SMD를 선택할 수 있다.) 

 

Qty.  Part       Ref des 

1  2N2905A PNP Transistor     TR3 

1  1.5 kOhm Resistor (1K5-MRS25-1%)   R1 

2  1N4148 Diode      D1, D2 

1  5.6 kOhm Resistor (5k6-MRS25-1%)   R2 

1  22 Ohm Resistor (22E-MRS25-1%)2    R3 

1  470 Ohm Resistor (470E-MRS25-1%)   R4 

2  3.3 Ohm Resistor (3E3-MRS25-1%)    R5, R6 

1  47uF/10V Elec. Cap (47uF-10V-EC)    C1 

1  1000uF/50V Elec. Cap (1000uF-50V-EC)   C2 
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이런 배열로 부품의 배치를 시도한다. 

 

6. 한번에 하나 이상의 symbol을 이동 할 수 있다. 키보드에서 <Ctrl> 버튼을 누르고 원하는 것을 

선택한다음 클릭 앤 드래그 한다. 

 

7. Polygon Select와 Freehand Select 기능을 사용하여 영역을 설정하여 

선택하는 방법을 사용해 보자. [Home] 탭을 선택하고 Select아이콘을 

클릭하면 여러가지 선택방법이 나타난다. Polygon Select를 선택하고 

사용자가 선택하고싶은 항목들 주위에 사각형을 그려 울타리를 만든다. 

모든 항목이 선택괴되었으면 선택을 종료하기 위해 왼쪽 마우스 버튼을 

더블클릭한다. 또는 Freehand selection mode를 사용한다면, 왼쪽 마우스 

버튼으로 클릭 앤 드래그를 하고 선택이 다 되었으면 마우스를 놓으면 

된다.  

 

 

[File] 탭 -> Options -> [Interaction]에서 추가적인 Selection 방법을 

지정할 수 있다. Selection methods를 Overlap과 Cover중에서 선택 

할수 있다. 

 

●   Cover를 사용하면 선택 영역에 완전히 포함된 항목만 선택한다. 

●   Overlap을 사용하면 선택 영역에 일부라도 포함된 항목을 모두 

선택한다. 
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현재 사용하는 Selection mode가 어떤것인지 커서의 모양을 다르게 표시하여 알려준다. Selection 

method는 선택 모양을 그리는 도중에 마우스 오른쪽 버튼을 클릭하면 토글 된다. 즉, 왼쪽 마우스 

버튼을 누르고 있는 상태에서 오른쪽 마우스 버튼을 클릭한다. 

 

주의 : Parts를 추가할 때 

경고창이 나오는 경우가 있다. 

이것은 “Part Acceptance”라는 

특별한 Attribute value를 가지고 

조정한다. 

 

 

위의 Parts Library 그림에서, ‘Part Acceptance’ 칸에 Parts의 수명주기 또는 재고관리 조치를 

사용자에게 전달하는 내용을 입력한다. 이것은 라이브러리 관리자가 지정한다. 

 

Part Acceptance 값을 포함하는 Part가 회로도에 추가될 때 다음의 경고창이 나타난다. 

 

이 Part를 사용하면 Parts List와 여러가지 보고서 출력에 반영하기 위해 그 값을 디자인에 저장한다. 

 

 

이 속성은 Item Properties 대화상자에 

반영된다. 

 

8. 모든 부품을 추가 한 후 SOLDEREYE-

1MM를 찾아 5개를 추가한다. 이들 

Parts는 한 핀으로된 Testpoint 부품으로 

제공된다. 

 

 

 

이 Parts는 battery pack에 와이어를 연결하기 위함이다. 따라서 이 Pad는9V와 다른 AGND에 

연결된다. 

 

Parts는 디자인이나 Sheet에 사용가능한 이름으로 할당 된다. 이름을 지정하거나 이름을 변경하는 

방법은 Item Properties 대화상자 같이 여러가지 방법을 이용한다. 
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9. SOLDEREYE중의 하나의 이름을 INPUT으로 변경한다. 이름을 변경하기 위해 

Parrts중의 하나를 선택한 다음 마우스 오른쪽 버튼을 클릭하고 Item 

Properties를 선택한다.  

 

앞의 부품 배치 그림을 참고하여 해당 이름을 입력한다. [Close]버튼을 

클릭하고 다음 Solder Eye part를 선택한다. 

 

같은 방법을 사용하거나 캐드스타 창의 오른쪽에 있는 non-modal Item 

Properties 자동숨김 패널을 사용한다. 

 

 

 

10. 패널 대화상자를 나타내기 위해 Item Properties 버튼 위에 커서를 놓는다. 

 

패널 대화상자가 열리면 선택된 항목의 속성이 나타난다. 많은 내용을 편집 할 수 있다. 

Reload와 Replace parts같은 기능들은 이 대화상자에서 실행할 수 있다. 다른 아이콘들은 

표준 Item Properties 대화상자와 Attribute Editor를 연결한다.  

 

 

 

스프레드 시트의 가독성은 <Ctrl>키를 누른 상태에서 마우스 휠을 스크롤하여 배율을 

조정하여 향상 시킬 수 있다. 

 

이전의 부품배치 그림을 참조하여 SOLDEREYE parts의 이름을 지정하는데 이 옵션을 

사용한다. 간단하게 Part를 선택하고 한번에 그 이름을 입력한다. Non-modal이기 때문에 대화상자를 

닫을필요가 없다. 

 

INPUT, INPUTGND, SPK, SPKGND, VCC9V 
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Connection 추가 

 

Connection을 추가하는 방법은 다음 3가지가 있다. 

 

a.  [Home] 탭과 Connection 버튼을 선택한다. 

 

 

 

기본적으로 Pin을 클릭하면 선택 목록이 나타난다.  

이 기능을 끄고 pin을 더블클릭하는 non-modal 방법으로 

Connection을 추가할 수 있다.  

 

이 기능을 끄기위해 [File] 탭 -> Options -> [interaction] 탭 그리고 Pick from List를 선택 해제 한다.  

 

b. 두개의 부품의 Pin을 서로 겹치게 놓으면 연결 된다. 부품을 이동하면 Connection을 볼 수 있다. 연결된 

핀은 자동으로 보이지 않는다. 

 

c. 빨간색 나비넥타이가 표시된 연결이 아직 안된 

핀에서 왼쪽 마우스 버튼을 누르고 드래그 하여 

다른 빨간 나비넥타이가 표시된 핀위에서 클릭하여 

배선을 완성한다. 

 

 

 

 

 

 

캐드스타는 Pin 이름이나 번호를 보이게 하거나 안보이게 할 수있다. 이것은 원래 2 pin non-polarized 

같은 디바이를 위해 라이브러리 작성자가 지정한다. 만약 이 Part들이 보이지 않게 지정되어 있다면, 

엔지니어는 다음처럼 전체적으로 무시할 수 있다. 

 

11. 리본메뉴에서 [File] 탭 -> Options -> [Display]를 선택하고 

Override Part Pin Name/Identifiers Visibility를 보이게 하거나 

안보이게 한다. 

 

캐드스타는 Connection이 겹치는 것을 방지하기 위해 Check 

기능을 제공한다. 
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12. [File] -> Options -> [Interaction]을 선택한다. 

 

Prevent Overlapping Connection selection이 체크되면, 

어떤종류의 연뎔단자를 드래그하고 다른 net name의 

Connection위에 배치하려고 하면, 캐드스타가 바로 Error를 알려준다. 

 

 
 

사용자가 원하는 시간까지 대화형 검사를 원하지 않으면, 간단히 선택을 해제한다. 디자인의 배치 

검사를 수행할 준비가 되면, 보고서 패널을 열기위해 Overlapping Connection active report 버튼위로 

커서를 이동한다. 

 

 

 

위 그림과 같이 Overlapping Connection report 버튼을 클릭한다. 결과 보고서의 내용은 hypertext이다. 

라인 항목을 선택하면, 회로도 창에 Error를 표시한다. 
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13. 아래 부분에 5개의 AGND Global Signal symbol을 추가하자.  

이 작업을 하기위해 Symbol 탭에있는 Global Signal 버튼을 클릭한다. 

 

(AGND)를 선택한다. 아래 그림처럼 AGND terminal과  

저항 R1의 terminal을 서로 겹치게 배치하여  

자동으로 연결한다. 
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14. 이전 페이지의 그림과 같이 모든 Symbol들의 연결을 완료한다. 앞에서 설명된 여러가지 방법을 

사용하여 배선을 해보자 

 

Connection을 추가할 때 (Add Connection) 또는 Conneciton을 

수정할 때 (Add/Edit Segment), connection이 자동으로 

장애물을 피하여 그려진다. 이 기능은 [File] -> Options -> 

[Interaction]에서 사용여부를 지정한다. 

 

Connection을 연결할 때, 마우스 오른쪽 버튼을 눌러 Change 

Default Net Route Code를 사용한다. 이것은 PCB 디자인에서 사용할 다른 Net-Route Code를 선택할 

수 있다.(일반적으로 다른 신호선보다 Power & GND 신호를 더 굵게 사용한다.) 

 

15. VCC net를 선택하고 Item Properties 아이콘을 클릭하여 VCC9V로 연결된 net name을 변경한다.  

 

16. AGND symbol의 핀을 선택하고 Item Properties 

아이콘을 클릭한다. AGND 신호선의 이름을 표시하기 

위해 Display Signal Name을 체크한다.  

 

주의 : 이것은 오직 표시의 목적이다. 신호선의 이름을 

표시하지 않아도 AGND 신호선의 이름은 그대로 

존재한다. 

 

주의 : 연결된 Symbol을 이동하면 당연히 생각되는것처럼 연결 

상태를 유지한다. Connection 자동 배선은 실시간으로 90도 수직 

Connection을 수정한다. 그러나 원한다면 이 기능을 끌 수 있다. 
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만약 [File] -> Options -> [System]에서 Automatic Version Increment가 사용되었으면 앞으로 symbol, 

component 그리고 part의 모든 변경사항이 있으면 version이 자동으로 증가하여 Library에 저장된다. 

사용자는 회로도나 PCB 디자인에 있는 부품이 현재 사용되는 Library Version과 매칭이 되는지를 쉽게 

확인할 수 있다. Symbol 탭에 있는 Reload를 클릭하여 확인한다. 

 

이 기능은 또한 Reset to 

Origin옵션을 선택하여 모든 

선택된 Parts에 대해 

Library에 정의된 대로 

Label, Symbol 그리고 Part 

name attribute들을 원래의 

위치로 되돌린다. 

 

이 그림의 Parts Library의 

내용과 다른 Parts가 사용된 

예를 보여준다.  

 

 

17. 완성 되었으면 회로도 디자인을 DesignA2.scm으로 저장한다. 만약, 위 과정까지 회로도를 완성하지 

못했다면, DesignA2_CS.SCM을 열어 DesignA2.scm으로 저장하여 사용한다. 

 

18. 최근의 사장상황에서는 설계 초기단계에서 BOM 

(Bill of Materials 이나 캐드스타에서는 Parts 

List라 한다.)을 제공하는 것이 중요한다. 

 

Parts List를 생성하기 위해, Parts List 버튼의 

윗부분을 클릭한다. 

 

출력 형식을 수정하고 싶으면 Parts List 버튼 

아래 부분을 클릭한다. 

 

 

 

 

 

 

 

 

 

 

 

 



  

CADSTAR Ver 16          Do-It-Yourself Book CADSTAR Express  
  

 

(주) 디엠에스에스 21 www.dmsscadstar.co.kr  
 

 

아래의 출력에는 Parts description과 Testpoint 부품이 포함되어 있다. 

 

           
 

만약 Parts List를 다른형식(사용자가 원하는 어떤 형식도 가능)으로 만들고 싶으면, Reports 탭에있는 

Report Generator 버튼을 클릭한다. 

 

      

          위의 그림은 [EDIT]버튼을 클릭하여 확장된 상태이다. 

확장된 상태에서는 버튼이 [DONE]으로 변경된다. 

 

Reports 폴더에 있는 part_list.rgf파일을 열고 [Run]만 클릭하면 된다. 사용자는 Parts List 형식과 모든 

attribute (wattage, voltage, tolerance, manufacture 등)를 선택한 특정 attribute를 기준으로한 

순서대로 원하는 형식으로 만들 수 있다. 

 

Visual Basic이나 C++ 사용경험이 있는 더 많은 고급사용자를 위해, 캐드스타에서 OLE 자동화를 

사용하여 예를들면, Micro Office Excel에서 사용자 정의 B.O.M을 생성할 수 있다. 
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19. 회로도 디자인을 프린트 하기 위해 간단히 [File] -> Print를 클릭하고 Page Setup을 한다. 또한 회로도 

디자인을 PDF 파일로 생성 할 수 있다. 추가로 PDF writer를 설치할 필요 없다. 캐드스타는 PDF 

writer가 내장되어 있다. 

 

팁 : Print 옵션에서 Alternative text output을 체크하면, PDF 파일을 만들 때 찾기가능한 글자로 

출력한다. 

 

20. 마지막으로, [Design] -> Transfer to PCB를 사용하여 

회로도를 전환한다.  

 

PCB파일은 자동으로 회로도 파일과 같은 이름을 

사용한다. 다른 이름을 사용하고 싶으면 [Browse] 

버튼을 클릭한다. 

 

오른쪽 그림과 같이 DesignA1.pcb로 지정한다. 

 

PCB Technology는 ‘2 layer 1.6mm.pcb’를 선택한다. 

[OK] 버튼을 클릭한다. 

 

작업 진행 중 회로도 디자인에 Error나 Warring를 

알려주는 보고서가 생성된다.  

 

 

 

 

 

 

 

다음은 PCB 설계에 필요한 Unit, Display Grid, Colour 

Template, Attribute 값등을 지정한다. 
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회로도에 Error가 없으면, 다음의 창이 나타난다. [Close]를 클릭한다. 

 

      

 

PCB 디자인이 관련된 리본스타일 GUI가 활성화 된 새로운 창에 나타난다.  
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주의 : 만약 PCB transfer 하는 동안에 ‘1 layer 1.6mm.pcb’ PCB Technology를 선택했다면, 기본 

technology 파일이 단면 설계에 적합하다. 다른 technology 파일의 장점은 사용자는 하나의 Library만을 

사용하여 작업을 할 수 있다는것이다. 디자인 D에서 경험하게 될 것이다. 

 

첫번째 단계에서는 디자인A의 회로도를 어떻게 그리는지 보여주었다. 사실, 어떤 화로도는 그 순서 다음에 

그릴 수 있다. 그러나 더 목잡한 디자인은 더많은 새로운 단계가 필요하다. CADSAR Design Editor에는 

회로도를 생성하기위해 설계자에게 도움을 주는 많은 기능이 있다. 또한, spacing classe의 추가, 

Connection을 삭제하지 않고 부품에 연결하기, Buss의 자동 연결작업을 할 수 있다. Align Symbol, 

Design-Reuse, Design Variant, Hierarchical Design등과 같은 다른 툴들도 또한 중요하며, 전문 회로 

설계자들이 사용하기 쉽다. 시도해 보자! 

 

이제 PCB 디자인으로 이동한다. 캐드스타는 Library, Schematic 그리고 PCB 디자인이 모두 같은 그래픽 

사용자 인터페이스를 사용하여 전환하는데 있어 문제점이 없고 확실하게 처리 한다. 
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제 2단계 – 디자인A의 PCB 배치 

 

앞에서 설명한 대로 PCB 디자인을 생성핮 못했으면, DesignA1_CS.PCB를 열어 DesignA1.PCB로 저장하여 

사용한다. 

 

1. [Design] -> Unit를 선택하거나 캐드스타창의 바닥에 있는 단위 를 더블클릭하여 

단위를 ‘Thou’(Thousandth of Inch)로 설정한다. 

 

2. 먼저, PCB 외형을 생성해야 한다. 

 

Board outline은 캐드스타에서 생성하거나 DXF 형식을 

Import 할 수 있다. 

 

[File] 탭 -> File Import -> Format -> DXF를 선택한다. 

 

DXF 파일 Boardoutline.dxf를 선택한다.  

 

Mapping-file은 user 폴더 아래있는 dxfin.map을 

선택하고 [OK]를 클릭한다. 

 

만약, DXF board outline을 Import하기로 정했다면 7번 항목으로 간다. 

 

주의 : DXF data를 사용하여 import된 board outline은 4번에서 설명된 것과는 다르다. 이것은 BLOCK, 

INSERT, ELLIPSE, SPLINE과 POLYLINEs과 같은 DXF line 형식들을 지원하는 것을 입증하기 

위한것이다. 

 

캐드스타는 또한 많은 기구 CAD 시스템에서사용하는 IDF 2.0과 3.0을 Import, Export 할 수 있다. 

 

3. 또는 board outline을 수동으로 그릴 수 있다. 

좌표값 입력창을 이용하여 작업을 해보자. 

[Home] 탭에서 default shape type 메뉴 목록단추에서 그림처럼 

Board를 선택한다. 다음으로 “Add Rectangle” 버튼을 클릭한다. 

 

마우스 오른쪽 버튼을 클릭하고 Input Coordinates를 선택한다. 

 

Width에 2100을 입력한다. 

Height에 1050을 입력한다. 

 

나머지는 그림과 같이 남겨둔다. 

 

[Apply]를 클릭한다. 
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주의  : 만약, Input coordinates를 이용하지 않고 그림을 그릴 경우에는, Board outline을 그릴 때 

캐드스타 창 바닥에 있는 절대 좌표와 상대좌표를 참고 한다. 

 

팁 : 디자인의 어떤 지점에서 ‘Z’하고 엔터를 치면 상대좌표가 재설정 된다. 

 

4. 어떤 외형(board, figure, component outline등)을 수정할려면, 그림을 클릭하고 조절점중의 하나를 

선택한다. 또한 캐드스타창 오른쪽의 Shape Properties 패널을 사용할 수 있다. 외형을 선택하여 

잘대좌표나 상대좌표를 확인하고 수정할 수 있다. 

 

 

 

5. 원하는 경우에 나사 구멍 또는 장착 구멍도 만들 수 있다. Board outline안에서 이 작업을 수행 하려면, 

defaults shape메뉴 목록단추에서 Cutout을 선택하고 그런다음 그리기 툴아이콘을 클릭한다. 이 

번경우에는 반지름이 50th인 4개의 원형 Hole을 추가해 보자 

 

Add Circle 아이콘을 선택한다. 

 

Board Outline을 클릭하고 마우스 오른쪽 

버튼을 눌러 Input coordinates를 

선택한다. 

 

Cutout의 Centter의 위치인 X 100, Y 

100을 입력한다. 

 

Radius은 50th로 입력한다. 

 

[Apply]를 클릭한다. Input coordinates 대화상자는 열린채로 둔다. 
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추가 Cutout을 그리기 전에 매번 Board outline을 선택하는 것을 기억하자. 이것은 캐드스타 창 바닥의 

명령어 줄에 나타난다. 

 

만약, 화면에 Board outline의 전체가 나타나 있다면, 사각형의 왼쪽 모서리에 첫번째 Cutout이 나타난 

것을 볼 수 있다. 

 

두번째 Cutout은 X 100, Y 950에 추가한다. 

 

목록단추를 눌러 이전에 사용한 값이 50을 선택한다. 

 

[Apply]를 클릭한다. Input coordinates 대화상자는 계속 열어둔다. 

 

계속해서 3번째 Cut-out은 X 2000, Y 950에 4번째 Cut-out은 X 2000, Y 100에 생성한다. 

 

만약 Board outline을 그리는 작업이나 DXF board outline을 import하는것을 완성하지 못했으면, 

DesignA2_CS.pcb 파일을 열고 DesignA2.pcb로 저장한다. Board모양은 위의 그림과 같다. 

 

Boardoutline이 Import되었거나 수동으로 그렸으면 모든 디자인 항목들의 X, Y 좌표값 그리고 

커서위치의 기준이 되는 Interactive origin을 설정 할 수 있다.  

 

6. [Design] 탭에서 Interactive Origin을 선택하고 Board의 왼쪽 아래 모서리에 

origin을 놓는다. 

 

 

 

 

Snap to Endpoint 기능을 사용하면, Interative Origin위 위치를 좀 더 쉽게 잡을 

수 있다. 이 기능을 사용하기 위해 [Design] 탭에 있는 All Sanp on/off를 

선택한다. 

 

 

 

Component 배치 

 

Board outline의 주위에 부품을 배열하거나 이동하여 시작한다. 

 

7. [Component] 탭에 있는 Arrange Component 기능을 사용하여 원점에 있는 

부품들을 이동한다.  

 

첫번째 대화상자에서 Place around board outline 옵션을 선택하고 [Next]를 

클릭한다. 
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Outside Board 

Outline 방법을 

지정한다. 

 

Component 

Separation을 

100으로 지정한다. 

 

[Finish]를 클릭한다. 

 

 

 

 

 

 

 

결과는 다르게 나타날 수 있다. 

 

 

 

Board outline안에 중요 부품을 배치한다. 이번 작업에서는 SOLDEREYE parts를 먼저 배치해야 한다. 기구 

설계자가 지정한 위치에 이들 중요한 부품을 배치해야 한다. 시용자는 Item Properties 패널을 사용하여 X,Y 

좌표, 회전 그리고 배치 면과 같이 배치 기준을 지정한다. 

 

8. 캐드스타 창 오른쪽에 있는 Non-modal Item Properties 패널을 연다. Pin 아이콘을 클릭하여 패널을 

고정시킨다. 

 



  

CADSTAR Ver 16          Do-It-Yourself Book CADSTAR Express  
  

 

(주) 디엠에스에스 29 www.dmsscadstar.co.kr  
 

 

9. 외형을 클릭하여 VCC9V component를 선택하거나 “VCC9V<Enter>”를 치면 된다. (이것은 자동으로 

하일라이트 된다.) 그런 다음 X-좌표를 250, Y-좌표를 875로 변경하고 Fixed 항목을 체크한다. 

Component가 새로운 위치로 이동 된다. PCB창을 클릭한다. 

 

다음 작업을 반복한다. 

 

SPKGND는 X-좌표를 450, Y-좌표를 875로 변경 

SPK는 X-좌표를 650, Y-좌표를 875로 변경 

INPUT은 X-좌표를 1650, Y-좌표를 100으로 변경 

INPUTGND는 X-좌표를 1850, Y-좌표를 100으로 변경 

 

10. 나머지 부품들은 [Tools] 탭에 있는 Embedd 아이콘을 선택하여 배치한다. 

 

 

 

[Home] -> stack off-Board 아이콘을 선택한다. 

 

 

 

모든 부품을 선택하기 위해 <Ctrl+A>를 친다. 이것은 현재 고정되니 않은 모든 부품들을 보드 주위에 

임의로 배치한다. 이것은 arrangr component의 두번째 옵션과 같다. 

 

11. Move 아이콘과 Componentmodefocus아이콘을 선택한다. 

 

 
 

12. “TR1”을 선택하고 Board Outline 안쪽으로 커서를 이동한다. 마우스ㅡ오른쪽 버튼을 누르면 그림처럼 

빠른메뉴 목록이 나타난다. 
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Clockwise나 Anti-Clockwise를 선택하면 부품이 시계방향이나 반시계방향으로 회전된다. 키보드에 

있는 ‘C’나 ‘A’을 눌러도 같은 결과가 나타난다. 

 

Swap을 선택하면 부품을 Mirror하여 반대쪽 면에 배치한다. 

 

Embedded에서 배치 기능을 오류없는 배치를 제공한다. 그러나 어떤 경우에는 오류가 일시적으로 

필요한 경우가 있다. 이럴 경우에는 부품을 임시로 Board Outline 밖으로 배치한다. 이것음 “Toggle 

Errors Allowed”를 선택하여 실행 할 수 있다. 

 

만약, 기본 동작이 다른 부품을 밀오내는 경우, Toggle Dynamic Pushing을 사용하여 밀어내기를 

해제할 수 있다. 

 

기본 동작은 [Home] 탭에 있는 Push -> Options 대화상자에서 지정한다. 

 

 

 

13. 아래 그림과 같이 TR1, TR2, TR3을 배치한다. 앞에서 설명한 기능을 연습한다. 
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14. 중요한 모든 부품들의 배치를 완료 한 후 Embedded를 빠져 나가고 [Component]탭에 있는 Arrange 

Components -> Automatic Placement 기능을 선택하여 남은 부품들을 배치한다. 

 

      

 

부품들을 배치하기 전에 모든 Auto Rotation angles을 체크한다. 세팅 방법을 다르게 하여 어떻게 다른 

결과가 나오는지 확인해 본다. 
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          0도와 180도 auto rotation만을 체크하여 배치한 샘플 

 

만약 부품의 배치를 완성하지 못했으면, DesignA3_CS.pcb를 열고 DesignA3.pcb로 저장한다. 

 

15. 조밀한 작업그리드 를 이용하여 수동으로 부품을 배치한다. (캐드스타 창 바닥에 있는 

Grid 버튼을 클릭한다.) 

 

참고 : PCB에서 Footprint를 간단히 선택만 하면 회로도에서 

관련된 symbol이 자동으로 선택 된다. 캐드스타에서는 이것을 

Cross-Probing이라 한다. 이 작업을 하기위해, 먼저 [View] 

탭에있는 Group -> New Vertical Group을 선택한다. 그런다음 

아무 항목이나 선택해 본다. 

 

다음 단계의 작업을 계속 하려면, PCB 디자인 창을 활성화 하고 

창을 확대해애 한다. 

 

Copper Pour를 위한 Powerplane Template 설정 

 

Powerplane은 PCB의 필수 요소이다. 캐드스타는 부분 powerplane과 DRC검사를 위한 경계영역을 설정하여 

지정된 Powerplane 층에 생성할 수 있는 Template 영역에 Negative Powerplane처럼 수행할 수 있다. 이것은 

전통적인 Negative 이미지 출력방법인 powerplane 츨력이 필요하다. 

 

Template는 Copper Pour 효과를 positive 이미지로 사용하기 위해 Electrcal층에 생성할 수도 있다. 이번 

연습에서는 사용자들에게 가장 인기있는 이 방법을 사용한다. 

 

16. 부분 powerplane을 생성하기 위해, Board outline을 복제하여 template를 생성한다. Board outline을 

선택하고 그런다음 [Net/Shape] 탭에서 Duplicate Shape 메뉴를 선택한다. 
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type을 Template로 변경하고 Layer를 Bottom Elec으로  

지정한다. 

 

Resize Shape은 선택하지 않는다. 

 

[OK]버튼을 클릭하여 Template를 생성한다. 

 

참고 : Copper pour는 Embedd나 PREditor에서  

Template 영역을 기준으로 Solder 면에 자동으로  

생성 된다. Copper 모양은 신호(예를 들면, AGND)와  

연결된 template 내부의 빈공간을 채우기 위해 생성된다. 

 

 

 

 

 

 

 

 

17. Template를 생성 한 후, Copper가 생성되는 방법을 제어하는 속성을 설정한다. Template를 선택하고 

non-modal Item Property 패널을 클릭하고 고정시킨다. 

 

주의 : 동영상에서는 AGND 신호를 사용할 Template Name을 Bottom AGND로 사용하였다. 

 

팁 : 만약 template 선택이 불가능 하면 [File] -> Options 

-> [Interaction] 탭에서 pick from list 기능을 체크한다. 

 

체크되면, Board outline을 다시 선택한다. 이번에는 

template outline을 좀 더 쉽게 하기위해 Select Item 

대화상자가 나타난다. 
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다음과 같이 지정한다. 

 

Name Template:   Bottom VCC9V 

Relief Copper Code:  10 

Layer:    Bottom Elec 

Signal Name:   VCC9V 

Clearance Width:   10 

Thermal Relief:   Enable On Pads 

Angle:    45° 

 

참고 : Automatic Pour를 체크한다. [이것은 중요한 

선택이다.] 

 

18. 17번 과정으로 가서 Top Elec층에 AGND를 

이용하는 Template를만드는과정을 반복한다. 

 

다음과 같이 지정한다. 

 

Name Template:   TOP AGND 

Relief Copper Code:  10 

Layer:    Top Elec 

Signal Name:   AGND 

Clearance Width:   10 

Thermal Relief:   Enable On Pads 

Angle:    45° 

 

이 장에서 언급된 단계는 일반적인 과정이다. 원형배치, Gate and Pin Swap, Replicate Placement등과 

같은 다른 기능들은 부품을 정확한 위치에 배치하는데 많은 도움이 된다. 
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제 3단계 – 디자인 A의 PCB 배선 

 

배치가 완성되면 이제 PCB 배선을 시직할 수 있다. 만약 template 생성이 완료되지 않았으면 배선작업 

영역으로 가기전에 DesignA4_CS.pcb를 열고 DesignA4.PCB로 저장하여 배선 작업을 하면 된다. 

 

1. [Tools] 탭 -> Embedded를 선택하여 배선작업 환경으로 이동한다. 

 

Routing Options을 확인하는것으로 시작한다. 배선을 하기전에 Routing Options을 확인하는 것은 매우 

중요하다. 

 

[Route] 탭에 있는 Routing Options 버튼을 선택한다. 

 

        

 

Routing Options 대화상자에는 배선 동작을 조절하는 많은 옵션들을 포함한다. 

 

배선 굵기, Routing Parameters (자동배선용), 배선각도, On-Line Design Rule Check, Push Aside, 

Activ-45 Degree Routing 등. 

 

적어도 On-line DRC, Angled Autorouting, Angle45 Degrees, Active-45 Degree Routing은 체크해야 

한다. 원하는 결과를 생성하기 위해 이들 옵션을 사용 할 수 있다. 
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2. 위의 그림처럼 [Home] 탭에 있는 Item Focus와 Manual  Route 두개의 아이콘을 클릭하여 매뉴얼 

배선을 시작한다. 

 

한쪽 Net를선택하고 Net의 다른쪽 끝으로 커서를 이동하여 Activ-45 Degree Routing을 사용해 보고 

Bottom 층에 자동 Copper Pour를 시작한다.  

 

Via를 삽입하려면, Top Elec에서 Bottom 

Elec으로 Layer의 변경이 필요하다. 배선의 

시작층을 변경하고 싶으면 캐드스타 창 바닥에 

있는 Top Elec 버튼을 클릭하고 Current 

layer를 Bottom Elec로 변경한다. 

 

배선 도중 마우스 오른쪽 버튼을 사용하고 

Change Layer를 선택하여 Via를 삽일 할 수 

있다. 

 

배선 굵기는 배선 작업 중에 마우스 오른족 

버튼을 눌러 빠른메뉴에서 Change Width를 

선택하여 Optimal에서 Necked로 변경하거나 

굵기를 변경 할 수 있다. (사용자는 Route 

Assignments 설정을 기준으로 Min과 

Max사이에서 선택 할 수 있다.) 

 

 

 

 

 

 

 

 

3. 자동배선 기능을 사용한다. 위의 그림처럼 Net Focus와 AutoRoute 두개의 아이콘을 사용한다. Net들은 

하나씩 하나씩 또는 전체 Board 주위를 드래그하여 자동배선 할 수 있다. 

 

automatic pour가 체크되었기 때문에 Copper Pour가 Top Elec과 Bottom Elec 층에 자동으로 생성된다.  
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참고 : template 안에 채워진 Copper는 사용자가 설정한 속성을 기준으로 수행 한 것이다. 또한 

Copper는 Board outline의 cut-out을 자동으로 피해서 생성된다. 

 

참고 : 위의 그림에서 보면 Transistor TR1-TR3은 부품 그림 안에 배선 금지대가 설정 되어 있다. 

Component Area가 보아지 않도록 Colour 설정을 변경 할 수 있다. 이 설정은 Allow in No Routing 

Area를 사용한 Template에 Copper Pour할 때 적용된다. 

 

4. 완성된 후에, 리본 메뉴에 있는 Exit Embedded를 클릭하여 

PCB Design Editor 창으로 되돌아 간다. Layout에 배선 

결과를 합치는 것을 잊지말자. 아래 그림과 비슷한 결과가 

나올 것이다. 

 

 

 

 

5. [View] 탭에 있는 Mix Colours(투명도)를 사용하여 PCB의 

상태를 다르게 볼 수 있다. 이것은 위의 그림처럼 여러층에 

있는 모든 내용을 보여 준다. 

 

참고 : 이 경우에 바탕색을 검정색으로 놓으면 더 잘 보인다. 

 

6. 만약 PCB 디자인을 뒤집어 보고싶으면, [View] 탭 -> Mirror View를 선택한다. 이 보기 옵션을 

사용하면 PCB의 바닥면에서 작업하는 것처럼 작업을 수행할 수 있다. 

 

7. File을 저장한다.  

 

만약 디자인의 배선을 완성하지 못했으면, DesignA5.pcb를 열면된다. 

 

이것은 PCB 설계의 마자막 단계이다. 여기에서는 어떤 Net는 매뉴얼로 배선해야 하고 위험한 Net는 

어떤것인지 배선을 어떻게 할것인지등 몇가지 주의 사항이 필요하다. 고급사용자 에게는 더 많은 배선 기능과 

High-Speed배선 기능이 필요하다. 
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제 4단계 디자인 A의 제조에 필요한 데이터 

 

이번 단계에서는 PCB 제조에 필요한 manufacturing data (Gerber, N.C.Drill, Parts List, Placement data, Drill 

Drawing등)도 생성할 수 있다. 아래 그림처럼 관련 Drii 표가 있는 Dril Drawing을 작성하여 시작한다. 

 

          

 

                        테이블에 Drill 개수에 해당하는 글자로 Drill 크기를 표시한다. 

 

1. 소수점 2자리로 표시되는 MM단위로 변경한다. 

 

2. Drill Drawing Colour 파일을 불러온다. 이 파일은 [View] 탭에 있는 Colour 

palette의 목록단추를 눌러 찾을 수 있다. 

 

명령어줄에 [col drill drawing <enter>]를 입력하여 불러 올 수도 있다. 

 

3. [Design] 탭에 있는 Drill Letters/Table 메뉴를 선택한다. 

 

 

 

 

 

 

                                                     a.  Automatic Drill Letter Association을  

                                                         선택한다. 

 

                                                     b.  Drill 글자를 더블클릭하고 tolerance  

                                                         항목에 +/- 0.02을 지정한다. 

 

                                                     c.  Length 항목을 선택해제 한다. 

 

                                                     d.  표에 나타나게 하기위해 Comments 칸을  

                                                         선택하고 ‘Tolerances’로 변경한다. 
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4. [Drill Table] 탭을 선택한다. 

 

a.  Layout 영역의 Layer 항목을 Letter 

Drill Drawing으로 변경한다. 

 

Show Drill Settings 항목을 선택하면 

PCB 제조에 유용한 관련 설정을 

보여준다. 선택되지 않은 상태로 둔다. 

 

b.  [Add Drill Table] 버튼을 클릭한다. 

커서에 Drill 표가 나타난다. 

 

 

 

 

 

 

 

5. PCB Board Outline의 오른쪽으로 표를 이동하고 아래 그림과 같이 놓기위해 클릭한다. 

 

 

 

6. 앞장에 있는 그림과 같이 치수선을 표시하기 위해 [Home]메뉴에서 

원하는 치수선 표기방법을 선택한다. 
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[Design]메뉴의 

Defaults 대화상자에 

치수선 표시에 대한 

기본값이 설정되어 

있다. 대화상자에서 

각각의 항목위에 

커서를 놓으면 

그림으로 설명이 

나타난다. 

 

 

 

 

 

 

 

 

 

 

 

 

팁 : 치수선을 표시할 때 [Design]탭에있는 Snap 기능을 사용해 보자. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. 리본 메뉴에서 [Manufacture] 탭을 선택하고 Batch Process 버튼을 클릭한다. 
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8. Batch Process 창에서 [Open]을 선택하고 ../Self Teach/ 폴더 아래 있는 Manufacturing Output 2 

Layer.ppf 파일을 선택한다. 

 

 

 

이 디자인은 양면 설계이기 때문에 다음과 같은 layer들을 생성한다. 

 

●   Top Elec 

●   Bottom Elec 

●   Top Solder Mask 

●   Bottom Solder Mask 

●   Top Silkscreen 

 

(모두 확장된 Gerber RS274-X 형식을 사용한다.) 

 

CADSTAR manufacturing에의해 추가적인 Data가 생성된다. 

 

●   Parts Lists 

●   Layer Stack up report 

●   Placement Data 

●   Drill Drawing (이 디자인의 경우 Drill Drawing layer에 대해 PDF를 출력하는 것이 좋다.) 

●   Drill Data 

 

동영상을 클릭하면 Drill Drawing을 PDF 파일로 만들기 위해 할 수 있는 추가 작업을 볼 수 있다. 

 

9. [Start] 버튼을 클릭한다. 제조에 필요한 모든 Data가 Oiutput폴더에 저장된다. 

 

주의 : 제조에 필요한 Data를 생성하는 동안, Area, Templates, Component Area가 보이는지에 대한 

점검을 한다. 만약 이런 항목들이 화면에 보여지게 되면 각각의 줄에 대하여 경고 메세지가 나타난다. 

만약 수정할 내용이 있으면 가각의 Colour File 칸을 클릭하고 [Edit File]버튼을 눌러 Visibility를 조정하여 

Gerber Datafh 출력하고자 하는 내용을 정확하게 설정한다. 수정이 완료되면 Colour 창의 [OK] 버튼을 

눌러 Batch Process 창으로 되돌아 간다. 
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사용자가 제조에 필요한 모든 Data를 생성하려면, 설계자에게 도움이 되는 치수성 표시(직교, 각도, 방사형등), 

Snap, Component Rename과 같은 다른 기능들이 있다. 

 

팁 : 캐드스타는 또한 Design Rule Check 기능을 제공한다. 이 기능을 실행하면, PCB 도면에 DRC Error가 

표시된다. 만약 Error를 수정하지 않으면, 제조에 필요한 Data 생성 시 알려준다. 
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제 5단계 – 다음에 재사용하기위해 디자인을 저장 

 

이런 앰프 같은 작은 회로도 및 PCB 디자인은 나중에 다른 회로의 일부로 사용하기위해 저장되는 회로의 

전형적인 예이다. 다른 디자인에서 불러 사용할 수 있게 일단 회로를 재사용 가능하게 저장한다. 캐드스타는 

재사용 회로를 관리하는 기능을 제공한다. 

 

 

 

1. 캐드스타창에 회로도와 PCB 모두를 나타낸다. 

 

2.  디자인의 Colour 설정 파일을 열고 Board Outline, Figures 그리고 dimentions을 Pickable을 No로 

설정한다. 

 

3. 간단한 프레임 방법을 사용하여 PCB의 모든 전기적인 내용을 선택한다. 만약 Cross Probing이 활성화 

되어 있으면 동일한 부품과 Net가 회로도 창에서 선택되어 나타난다. SOLDEREYE 부품은 선택을 

취소한다. 

 

4. [Design] 탭에서 Manage Reuse Blocks -> Create Reuse Block을 

선택한다. 재사용 블록의 기본 위치는 [File] 탭 -> Options 

대화상자의 File locations에 지정된 Reuse Files 폴더이다.  
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5. 파일에 대한 의미있는 이름을 선택한다. 즉, “Amplifier”라고 

입력하고 [OK]를 클릭한다. 

 

6. Reuse Block 이름도 같은 이름을 입력하고 [OK] 버튼을 

클릭한다. 

 

 

7. Cross Probing 때문에 여전히 회로도 Data가 선택되어있기 때문에, 회로도 파일 탭을 조심스럽게 

클릭한다. (탭이 아니고 창 안쪽을 클릭하면 선택된 내용이 취소된다.) 이것은 리본 메뉴를 

회로도용으로 바꿀 것이다. Circuit Block을 다시 선택하고 [Design] 탭을 선택하고 Create Reuse 

Block을 선택한다. 

 

만약 사용자가 회로도 작업영역을 클릭하여 선택해제를 하게되면 회로도 Data에 대한 작업을 반복해야 

한다. 회로도 재사용블록에도 PCB 재사용 블록과 같은 이름을 지정한다. 즉, Amplifier.scm 

SOLDEREYE 부품은 포함하지 않는다. 

 

8. Manage Reuse Blocks 버튼을 선택한다. 새로운 블록의 이름이 나열된다. 

 

 

 

참고 : Reuse Block 파일의 이름을 지정하기 때문에 이 기능을 사용하면 \Reuse Files\폴더 내에서 

관리 할 수 있다. 만약 Block을 변경하기로 지정했다면, Amplifier 회로도와 PCB 파일을 모두 

업데이트 한다. 그런다음 Amplifier 회로를 사용하는 어떤 디자인에서 간단히 더블클릭하고 위의 

그림처럼 Update 항목을 체크하여 업데이트 한다. 

 

다음 과정에서 Design B, Amplifier reuse block을 사용할 것이다. [Design] 탭에서 Manage Reuse 

Blocks -> Insert Reuse Block 그리고 Amplifier를 선택한다. 
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Reuse 회로에 대한 고유 이름지정 

 

이러한 회로를 재사용하기 전에 이름을 바꾸는 절차를 수행하는 것이 좋다. Reuse 회로 Block에 사용된 

회로도와 PCB 부품의 고유 이름을 할당하고 또한 그들이 Reuse 회로 Block으로 삽입 될 때 캐드스타는 

자동으로 이름을 변경하는 작업을 최소화 한다. 

 

예를 들어, 회로도와 PCB에 Reuse Block을 삽입 할 때, Reuse 회로에 사용된 부품번호가 이미 사용되었다면, 

CADSTAR는 자동으로 중복된 부품이름을 순차적으로 사용가능한 이름으로 변경한다. 이것은 회로도 및 PCB 

Reuse Block 사이의 동기화가 어긋날 수 있다. 

 

좀 더 현명한 해결책은 부품이름을 큰수로 변경하는 Rename 기능을 사용하는 것이다. 

즉, R1 -> R1001, C1-> C1001 

 

9. Amplifier 회로도와 PCB 파일을 열어 두 가지를 동시에 보이게 하고 회로도에서 작업을 하기위해 

회로도 창을 클릭한다. 

 

 

 

10. [Symbol] 탭에서 Positional 버튼을 선택한다. 

 

11. R로 시작하는 부품에 대해 그림과 같이 설정한다. 

 

이것은 저항들을 왼쪽에서 오른쪽 – 위에서 아래 순으로 10001부터 시작하여 이름을 변경한다. 

 

C, D 그리고 TR의 이름에 대하여도 반복한다. 
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12. \Reuse File\ 폴더에 현재 버전을 덮어써서 Amplifier 회로도를 다시 저정한다. 

 

회로도에서 변경된 부품의 이름을 ECO Update 기능을 사용하여 PCB에 전달한다. 

 

13. PCB에서 작업을 하기 위해 PCB 창을 클릭한다.  

 

14. [Design] 탭을 클릭하도 ECO Update 버튼을 클릭한다. 

 

다음의 대화상자가 나타나면 [Yes] 버튼을 클릭한다. 
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15. ECO 기준 파일로 \Reuse File\ 폴더에서 Amplifier.scm을 선택한다. 

 

16. 그림과같이 설정하고 [OK] 버튼을 클릭한다. 

 

17. 디자인 비교 결과 창에서 [YES] 버튼을 클릭한다. ECO Update 결과 보고서가 나타난다. 

 

  

 

                  

 

 주의 : ECO Upddate는 Net 번호를 변경시킨다. 

중요 Net는 기본 Net 번호를 사용하지 말고 

별도의 이름을 사용하는 것이 좋다. 
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18. 보고서를 주의깊게 살펴보고, [Close] 버튼을 클릭한다. 변경사항을 수용할 것인지 확인하는 창이 

나타난다. [Yes]를 클릭한다. 

 

 

 

PCB 디자인이 회로도와 일치하도록 업데이트 된다. 

 

19. \Reuse File\ 폴더에 현재 버전을 덮어써서 Amplifier PCB 디자인을 다시 저정한다. 

 

 

 

첫번째 디자인 설계가 완성되었다. 
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캐드스타 3D 

 

완성된 캐드스타 PCB Design을 Board Modeler Lite 로 체크할 수 있다. 캐드스타 3D는 STEPS AP203, AP214, 

ACIS, STL형식의 formats을 Import/Export할 수 있으며 PCB 디자인의 3D 상태에서 PCB 디자인의 배치와 

검증을 위한 최적의 솔루션을 사용자에게 제공한다.  

 

ⓐ       보드 외형을 바꾸고 부품 배치정보가 자연스럽게 Back Annotate 된다. 

 

ⓑ       3D parts creation 마법사를 이용하여 자세한 3D 모델을 생성한다. 

 

ⓒ       Housing 을 Import 한다. ( 혹은 다른 PCB 디자인 ) 

 

ⓓ       측정하고 거리를 Check 한다. 

 

ⓔ       완벽한 Collision Check 를 수행한다. 

 

Board Modeler Lite는 단지 뷰어가 아니다 

 

http://www.zuken.com/products/cadstar/physical/board-modeler-lite.aspx 에서 더 많은 정보를 

확인할 수 있다. 
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배치와 배선이 완료된 디자인 B 

 

 

 

여기에서 캐드스타 PCB Design 을 Board Modeler Lite 로 체크할 수 있다. Board Modeler Lite 는 STEPS 

AP203, AP214, ACIS STL 그리고 IDF 형식의 formats 을 Import/Export할 수 있으며 PCB 디자인의 3D 

상태에서 PCB 디자인의 배치와 검증을 위한 최적의 솔루션을 사용자에게 제공한다. 보드 외각을 교체하거나 

다른 PCB Design 또는 Housings 을 import 하고 부품 배치 정보가 자연스럽게 Back Annotate 된다. 이러한 

정보들을 모두 통합하여 3D를 만들고 완벽한 collision check 실행하여 몸체간의 충돌여부를 점검할 수 있다. 

캐드스타 3D는 단지 뷰어가 아니며 http://www.zuken.com/products/cadstar/physical/board-modeler-

lite.aspx 상에서 더 많은 정보를 확인할 수 있다. 
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●  제 2 장 - Design B 

  

  

디자인 B에서는, 디자인 A에서 배운 내용보다 더 많은 캐드스타의 기능을 알아본다. 여기에서는 회로도와 PCB 

디자인 둘 다 Reuse Block 형식으로 Amplifier 회로를 사용할 것이다. 회로도는 계층 구조를 사용할 것이고, 기

구 CAD의 예를들어 부품 배치 영역이 지정된 좀 더 복잡한 Board 외형을 사용한다. 

 

이제 설계할 프로젝트는 많은 전자 취미가들이 불면증을 치료하기 위해 만든 오디오 장치이다. 이 회로는 빗방

울 소리를 모방한다. 이것은 백색 잡음 발생기와 유사하다. 

 

회로도는 www.electroschematics.com에서 무료로 다운 받은 것이다. 여기에 amplifier를 추가하여 버튼을 눌러 

동작하게 할것이다. 

 

 

 

PCB 설계는 부품을 좌표값을 이용하고 회전을 하여 작업을 할 것이다. DXF 파일을 Import하고 나머지 부품을 

배치한다. 

 

배선과 배치는 Embedded Place and Route Editor를 이용하여 작업을 한다. 

 

그런다음 위의 회로도를 기준으로 

Rainmaker라는 디자인를 완성하기 위해 새

로운 기능을 사용한다. 

 

아래 그림에는 완성된 Rainmaker PCB 디

자인을 포함한다. 3D model은 CADSTAR – 

Board Modeler Lite에서 가능하다.  
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1 단계 – 디자인 B의 회로도 

 

작업 순서는 디자인 A와 동일하다. 

 

1. Form A4-euro를 사용하여 새로운 회로도를 생성하고 Working Grid를 Thou 그리고 Screen Grid를 

100, 100으로 설정한다. 

 

2. Library 작업창에서 부품을 선택한다. Library Searcher를 이용할 수도 있다. 

 

Parts List는 다음과 같다. 

 

Part Name/Number Description    Qty Comps. 

0.1UF-COG2-5%  0.1uf 100V COG Mlayer Ceramic  1 C2 

100-TR4-1%  100 Ohm TR4 Metal Oxide Film 1%  1 R5 

10UF-10V-EC  10uF 10V Electrolytic Capacitor  1 C4 

2.5MM PWR CON  Power supply connector 2.5mm  1 J1 

220E-TR4-1%  220 Ohm TR4 Metal Oxide Film 1%  1 R7 

220K-TR4-1%  220K Ohm TR4 Metal Oxide Film 1%  1 R6 

270K-TR4-1%  270K TR4 Metal Oxide Film 1%  2 R2-3 

2K7-TR4-1%  2.7K TR4 Metal Oxide Film 1%  1 R1 

2N1613   SABER TRANSISTOR   1 Q2 

2N3904   SABER TRANSISTOR   1 Q1 

470E-MRS25-1%  Metal film resistor MRS25 470E 1%  1 R4 

BA156K0103J--  Leaded film capacitor   1 C3 

BA156K0104J  1nf Leaded film capacitor   1 C1 

LM741CN  SINGLE OPERATIONAL AMPLIFIER  1 U1 

NEC_TOKIN_UC2_RELAY NEC TOKIN's UC2 Mini Signature relay 1 RL1 

RS15H11AA04M-100K Slim Slide™(Slim 4) RS**H Series 100K 1 P1 

RS15H11AA04M-50K Slim Slide™(Slim 4) RS**H Series 50K 1 P2 

SOLDEREYE-1MM  Soldereye 1.0 mm    2 SP1-2 

TL1250F180BQRCLR SPST - Tactile Switch N.O with Blue Led 2 SW1-2 

 

3. 회로도 Sheet에 부품을 배치한다. 다음 페이지에 있는 완성된 회로도를 참고한다. 좀 더 보기쉽게 하

기위해 프린트 한다. 

 

심볼이 Mirror되고 회전되는 것을 유념하자. 그러나 대부분의 경우 회로도와 일치하는 Alternate 심볼

을 사용한다. 

 

Parts STP1은 2-pin Star point 심볼이다. 이것은 Library에 들어있고 큰 하나의 Pad로 구성된 PCB 

stat point footprint를 갖는다. 사실 이것은 ground reture처럼 두 개의 Net가 특정위치에서 배선을 사

용하여 서로 연결되게 하는 특별한 부품이다. 

 

Optional Amplifier로 나타난 Block 모양은 계층구조 Block이다. 이것은 나중에 언급한다. 
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빨간색 심볼은 스피커를 표현하기 위해 Figure로 그렸고 그룹화 되었다. 이 프로젝트에 대한 실제 스

피커는 PCB에 장작되지 않는다. Solder eye terminal이 사용된다. 

 

다음의 기능을 이용하여 회로도 내용을 적당히 조정한다. 

 

          ■ 심볼의 크기 조정은 Item Properties 대화상자를 이용한다. 

          ■ 글자의 크기와 폰트(한글폰트 포함)는 Assignment Settings를 이용한다. 

          ■ Part의 Attribute의 위치 

          ■ Colour는 Colours 대화상자를 이용한다. 

          ■ 저항과 non-polarized 부품과 같은 parts에 대한 pin name/Identifiers의 표시 여부 

 

4. Rainmaker1.SCM으로 디자인을 저장한다. 

 

5. 부품들을 연결한다. - Connection들이 다른 색상으로 표시 된 것을 주지한다. 이것은 Route Code별로 

다른색상을 사용하였기 때문이다. 

 

Power Net(빨간색)는  Net Route Code VCC 사용 

Ground Net(녹색)는  Net Route Code GND 사용 

다른 모든 Net(보라색)는  Net Route Code Signal 사용 

 

6. 이에 따라Global Signal을 추가한다. 이들은 고유한 Net 이름을 갖을 수 있다. 각각의 이름은 회로도에

서 확인한다. 

 

7. 선택 단계. Spacing classes 사용법

을 배우게 되면, Net 그룹간에 별

도의 Spacing을 지정하여 매우 우

용하게 사용할 것이다. 회로설계자

는 회로도에 이 정보를 정의 할 수

있어 매우 편리한다. 
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8. Rainmaker2.scm으로 디자인을 저장한다. 

 

이제 이 디자인에 두 번째 Sheet를 추가하자. 이 Sheet는 Sheet에서 Sheet로 이동 할 때 Push down

과 Pop up 할 수 있는 lower level 계층 Sheet가 될 것이다. Sheet를 연결하기위해 lower sheet에연결

된 신호를 에뮬레이션 할 Terminal이 있는 계층 Block을 추가한다. Signal 이름은 아래 그림에서빨간

색으로 표시된다. Block의 이름은 “Optional Amplifier”이다. 

 

    

 

9. [Hierarchy] 탭에서 Add Block shape을 선택한다. 위의 그림과 같이 적당한 위치에 사각형을 그리기 

시작한다. 

 

10. Block 모양 외형을 더블클릭한다. 다음과 같은 창이 나타난다. 

 

[Create New Sheet]를 선택한다. 

 

새로운 Sheet의 이름을 “Optional 

Amplifier”로 입력한다. 

 

[OK] 버튼을 클릭한다. 

 

 

 

 

 

 

 

 

Sheet 2 of 2를 사용한 같은 형식의 Sheet Symbol을 사용하여 새로운 회로도 창이 나타난다. 
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11. 자동 숨김으로 되어있는 Open Designs 패널을 보이게 한다. 

새로운 Sheet가 부모 Sheet1의 자식 Sheet로 들여쓰기하

여 나타나는 것을 확인한다. 

 

주의 : 원한다면 여기에서 Sheet1의 이름을 바꿀 수 있다. 

이름을 클릭하고 마우스 오른쪽 바튼을 눌러 나타나는 빠

른 메뉴 목록에서 Rename Sheet를 선택한다. 

 

주의 : 새로운 Sheet는 Add Sheet를 선택하여 같은 방법으

로 추가한다. 

 

Top Level Sheet는 Sheet1과 같은 Level이 될 것이다. 

 

Lower-level Sheet를 추가하면 Unconnected Sheet로 생성되

고 밝은 파란색 아이콘으로 나타난다. 이것은 계층 블록이 

원하는 부모 Sheet아래 새로운 자식 Sheet로 연결이 필요하

다. 

 

 

12. Optional Amplifier Sheet안에서 빈 공간에서 마우스 오른쪽 버튼을 클릭한다. 부모 Sheet로 올라가기

위해 Pop Up 옵션을 클릭한다. 

 

이 기능 뿐만 아니라 Push Down이나 계층 블록 모양을 더블 

클릭하면 Sheet에서 Sheet로 쉽게 이동한다. 

 

다음으로 Sheet사이에 Net 연결을 에뮬레이트하는 연결지점 

역할을 하는 터미날을 추가한다.  

 

주의 : Transfer to PCB, ECO Update, Back Annotation과 같

 은 작업 과정에서 일반적인 Signal Name을 자동으로 연결하므로 이 작업은 선택사항이다. 

 

13. [Hierarchy] 탭의 Add Terminal 영역에 있는 Downward 옵션을 클릭한다. 

 

 

 

 

 

주의 : 메뉴를 선택하면 다음 작업의 지시가 캐드스타창 왼쪽 아래부분에 나타난다. 

 

 

 

 



  

CADSTAR Ver 16          Do-It-Yourself Book CADSTAR Express  
  

 

(주) 디엠에스에스 56 www.dmsscadstar.co.kr  
 

 

Block 모양을 클릭한다. 대화상자에서 Signal 

Name 목록 단추를 클릭하여 AGND를 선택한다. 

 

Terminal Code를 Hierarchy로 변경한다. 

 

[OK]버튼을 클릭한다. 

 

그림과 같이 Block 외형의 아래 부분에 Teminal을 

놓는다. 

 

키보드의 <esc> 키를 누르거나 마우스 오른쪽 버

튼을 클릭하여 Cancel을 선택한다. 대화상자로 되돌아 갈 것이다. 

 

마찬가지로 새로운 Net 이름을 지정한다. 

 

그림과 같이 Signal Name 12V_B를 선택한 다음 

[OK]버튼을 클릭하여 Block의 위부분에 이 

Terminal을 놓는다. 

 

그림과 같이 SPK+IN과 SPK+OUT을 놓기 위해 이 

과정을 반복한다. 

 

마우스 오른쪽 버튼을 클릭하고 Finish를 선택한다. 

 

원하는 위치에 Terminal Name을 놓기위해 이동 할 수 있다. 

 

14. Block 심볼에 이름을 지정하기위해 외형을 선택

하고 그림과 같이 Optional Amplifier를 입력하

고 [OK] 버튼을 클릭한다. 

 

 

 

 

 

 

 

 

 

 

 

 

 

15. Lower level terminal을 보기위해 Optional Amplifier로 Push Down한다. 각각의 Terminal이 나타나고 

관련된 계층 terminal이 lower sheet의 같은 X, Y 위치에 나타난다. 
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팁 : 동영상에서 처럼 Hierarchical terminal code를 변경 할 수 있다. 만약 그렇게 하고 싶으면 Item 

Properties 창을 이용한다. 예를 들면 상위 hierarchical terminal에서는 Cross terminal code를 계속해

서 사용하고 하위 Sheet에 있는 Hierarchical terminal은 채워진 화살표를 사용 할 수 있다. 

 

16. Sheet1으로 Pop Up 하고 회로도 그림과 같이 새로운 계층 Terminal에 Connection을 추가하여 완성한

다. 같은 색의 상관관계를 유지하기위해 Route Code를 설정해야 한다. 

 

 
 

17. Rainmaker3.scm으로 디자인을 저장한다. 

 

이제 1장에서 저장한 저장한 재사용 가능한 회로 블록을 추가할수 있다. 

 

Lower level 회로 블록을 생성하는 것은 Reuse 블록을 추가하는 목적이 아니더라도 디자인을 간결하게 보

이는 좋은 방법이다. 

 

18. Lower level sheet로 Push Down한다. 

 

19. [Design] 탭에서 Manage Reuse Block -> Insert reuse Block을 선

택한다. 

 

Amplifier 회로도 블록을 선택한다. 

 

Block은 Component 이름과 Net 이름이 이미 사용되었는지 비교 

확인하여 디장인에 통합된다. 

 

중복된 Component 이름은 각각의 이름 어근에 해당하는 사용가능한 다음이름으로 변경된다. 

 

증복된 Net 이름은 다음의 대화상자가 나타나 사용자

가 Net를 합칠 것인지 분리하기위해 이름을 변경변경

할 것 인지 결정한다. 

 

AGND 계층 Terminal이 starpoint 부분에 연결되었기 

때문에 Net가 실제로 존재하고 같이 연결 할 수있다. 

[Join]을 클릭한다. 

 

다음에 나오는 대화상자에서 결정하는 내용이 매우 중요하다. 만약 사용자가 두 회로의 모든 Net 이
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름을 인지하고 있어 동의하는 경우에는 모든 중복된 Net에 대해 Join 작업을 반복한다. 그렇지 않으

면 사용자가 실수로 두 개의 Net가 서로 연결되는 것을 피하기 위해 각각의 Net 마다 매번 반복 작업

을 힐 수 있다. 

 

20. 이제 Amplifier 회로가 커서에 붙어 나온다. Sheet에 배치한다. 

 

이제 회로가 그룹화 되고 Reuse 블록으로 고정된 상태이다. 

 

21. Current Design 패널 메뉴를 연다. 현재 회로도에 있는 reuse 블록을 보

기위해 Reuse Blocks 부분을 확장한다. 

 

 

 

 

 

 

 

22.  각각의 Net 근처에 Lower level 계층 Terminal을 배치하고 적당하게 연결한다. 

 

AGND

12V_B

SPK+IN

SPK+OUT

R13
3E3

C6
P
+

N

1000uF

R8
1K5

R10
22E

R9
5K6

D1

C
A

1N4148

R12
3E3

D2

C
A

1N4148

TR2
C

B

E

2N3053

R11

470E

TR3

C

B

E

2N2905A

TR1
C

B

E

2N3053

C5
P
+

N

47uF

 

 

23. Parts List를 생성한다. – 대화상자가 나타나면 두개 Sheet 모두 선택한다. 

 

24. 디자인을 프린트 한다. 

 

25. Rainmaker4.SCM으로 디자인을 저장한다. 
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26. 회로도를 PCB로 전환 한다. (PCB technology는 ‘2 

layer 1.6mm.pcb’를 선택한다.) 

 

 

Design Reuse Block을 사용했으므로 오른쪽 그림처

럼 반드시 Perform Update of Reuse Block on 

Completion을 체크한다. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

디자인에 추가되는 새로운 항목에 관련된 여러 개의 확인 대화상자가 나타날 것이다. 

 

주의 : “STAR-POINT_2-

PIN”의 Parts library 

definition에 사용된 Part 

Acceptance attribute의 

내용이 경고 내용으로 나

타난다. 여기에서는 “Not 

a physical part”라고 지

정되어있다. 이것에 관하

여는 다음 장에서 배우게 

된다. 

 

Reuse Block Update 요

약 리포트가 나타날 때까

지 수용한다. 
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[Close] 버튼을 클릭한다. 

 

새로운 PCB 디자인은 다음 그림과 같이 그룹과 Reuse 블록으로 나타난다. 

 

주의 : Reuse 블록은 그림을 잘 보이게 하기위해 저자가 원래 위치에서 약간 이동시킨 것이다. 
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2 단계 – 디자인 B의 PCB 배치 

 

전환 후 PCB에 부품들이 준비되고 배치를 시작할 수 있다. 이 시점에 디자인이 완성되지 않았다면, 

Rainmaker4_CS.PCB 파일을 불러온다. 

 

1. Unit와 grid를 확인하고 변경한다. (25 thou가 적당하다.) 

 

2. Board Outline을 불러올 자리를 만들기 위해 Amplifier 회로를 클릭하여 부품들의 오른쪽으로 이동한다. 

 

3. \Self Teach 폴더에 있는 Rainmaker_Boa.dxf를 이용하여 DXF Board Outline을 불러온다. 또한 같은 

dxfin.map 파일을 사용한다. DXF파일에는 또한 기구설계에서 제공한 중요 부품 위치와 Dimension과

같은 다른 정보들을 포함한다. 

 

 

 

주의 :  위그림에서 보면, 디자인에 4개의 위치가 고정된 부품이 추가 되었다. 이것은 하나의 Pad로 구성된 

Component로 가져와 mounting Hole로 사용된다. DXF Import 과정에서 Component 모양과 부품이름을 인정합

니다. 만약, 이것이 디자인에 없으면 캐드스타는 Parts library에서 가져올 것이다. 이에 대한 내용은 CADSTAR 

도움말에 자세히 설명되어 있다. 

 

팁 : DXF 파일의 모든 정보가 PCB 창에 표시된 후에는 Connection이 가장 짧은 길이로 최적화 되지 않는다는

것을 알 수있다. 이것은 [Net/Shape] 탭에있는 Reconnect 기능을 이용하여 빠르게 해결 할 수 있다. 이 기능

은 Connection의 연결상태를 최적화하여 간단하게 표시해 준다. 이것은 Signal Integrity 제약조건에 어떤 영항

도 주지 않는다. 
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Reconnect 기능을 수행 한 후 표시된 PCB 디자인 

 

4. 다음으로 reuse 회로 블록을 배치하기 위해 이동한다. Block이 그룹화 되어있기 때문에 클릭하여 하나

의 개체처럼 이동한다. 또한 어떤 각도로도 회전할 수 있다. 다음 페이지처럼 Block을 배치한다. 

 

5. Starpoint STP1, relay RL1 그리고 SP1과 SP2 부품들을 다음 페이지를 참고하여 적당한 위치에 배치한

다. 배치를 한다음 마우스 오른쪽 버튼을 클릭하여 빠른메뉴에서 Fix 기능을 클릭하여 이것들을 고정한

다. 
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주의 : amplifier reuse 블록은 적합하지 않다. 아마 PCB 설계 유경험자에게는 정상적인 것이다. 나중에 관련된 

reuse Block을 제거하여 배치도 조정하고 Copper pour template도 조정할 것이다. 연습의 요점은 기본 디자인 

Reuse 사용법이다. 

 

6. [Tools]탭에 있는 Embedd Place and Route 아이콘을 선택한다. 

 

7. [Home] 탭에있는 Stack 기능을 이용하여 Board outline 주위에 부품을 정리한다. 

 

 

 

8. Component mode focus 아이콘과 Move 아이콘을 선택하여 다른 부품들을 수동으로 배치한다. 

 

9. Embedd Place and Route를빠져나가고 PCB 디자인을 저장한다. 
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배치가 완료된 예 

 

만약, 부품의 배치가 안되었으면 Rainmaker5_CS.PCB 파일을 연다. 

 

Reuse 회로 블록의 조정 

 

여기에서는 이 보드 외형에 맞게 회로 블록을 조정할 것이다. 

 

10. Amplifier reuse 블록을 선택한다. Non-

modal Item properties 패널에서 그룹 지정

을 해제한다. 

 

11. Reuse Block에 있는 기존의 Copper Pour 

Template의 모양을 수정하기 시작한다. 그

림과 같이 보드 외형의 왼쪽을 선택하고 

늘린다. 

 

 

 

12. Template에 있는 원형 Cutout을 제거한다. 

각각의 Template에 4개씩 모두 8개이다. 
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13. 캐드스타 창의 왼쪽에 Current Design 패널을 연다. Reuse Block

부분을 확장하고 Amplifier 이름을 클릭하고 마우스 오른쪽 버튼

을 눌러 빠른메뉴에서 Remove Reuse Association을 선택한다. 

 

원한다면 회로 블록의 어떤 편집도 자유로이 할 수 있다. 

 

주의 : Reuse association을 꼭 제거할 필요는 없다. 이것은 선

택 사항이다. 만약 PCB 디자인이 이 기술을 보증한다면, 회로

도 reuse block도 reuse association을 제거하는 것을 권장한다. 

 

그러나 만약 Block이 복잡하여 주의 해야 하고 나중에 Cross 

probing을 이용하여 회로도 창에서 PCB 블록 항목들을 remote 

select 한다면 회로도와 동기화 하기위해 사용자는 같은 이름의 

새로운 reuse block을 생성할 수 있다.  

 

14. Top과 Bottom면 모두에 있는 Copper 모양과 연관된 Template를 선택하고 삭제한다. 

 

15. [Tools]탭에 있는 Embedded Place and Route를 선택한다. 

 

16. Component focus mode에서 Move명령어를 사용하여 두개의 capacitor와 R1005를 적당한 위치로 수

정한다. 

 

만약 발생하는 Error를 무시하고 싶으면, 마우스 오른쪽 버튼을 눌러 빠른 메뉴에서 Toggle errors 

allowed를 선택한다. 

 

부품을 이동할 때 배선은 유지되어야 한다. 

 

17. Embedd Place and Route를 빠져나가고 PCB 디자인을 저장한다. 

 

배치가  

완성된 예  

-> 
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만약 부품배치를 건너뛰고 싶으면, Rainmaker6_CS.PCB를 열고 Rainmaker6.pcb로 저장하여 사용하면 

된다. 이 파일은 Copper와 Template가 이미 삭제 되어 있다. 

 

18. Rainmaker 회로의 power와 ground net를 보강하기위해 네개의 새로운 template를 생성한다. GND와 

AGND template는 Top 층에, 12V와 12V_B template는 Bottom 층에 놓는다. Item Properties를 이용하

여 template에대한 조건을 설정한다. 

 

아래의 그림을 참고하여 template의 모양을 그린다. AGND와 GND로 녹색으로 표시되었다. 12V와 

12V_B는 빨간색이다. Template는 Board outline 바깥쪽에 그려도 상관 없다. Copper pour기능은 오직 

Board outline에서 Copper to Profile spacing 만큼 안쪽에만 채우기를 할 것이다. 

 

 

 

제 3단계 – 디자인 B의 배선 

 

이제 PCB 디자인의 마지막 단계이다. 이 작업을 위해 배치된 Amplifier reuse block에 이미 존재하는 배선이 수

정되지 않도록 Fix 명령어를 사용한다. 

 

1. [Tools]탭에 있는 Embedd Place and Route 아이콘을 선택한다. 

 

2. SW2에 있는 12V, 12V_relay 그리고 12VA 처럼 중요한 Net는 수동으로 배선한다. (아래 그림을 보면 

12V template 연결지점 근처까지만 부분 배선되었다.  

 

3. 모든 항목을 선택하기 위해, 프레임 기술을 사용하여 PCB 외형의 주의에 사각형을 그린다. [Home]탭

에있는 Fix 명령어를 클릭한다. 
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4. 다른 모든 Net들을 자동 배선 한다음 Activ-45 routing mode를 사용하여 수동 배선을 산다. 이것은 마

우스 오른쪽 버튼을 눌러 빠른메뉴에서 찾을 수 있다. 

 

주의 : 4개의 power와 ground net에 연결된 핀들은 배선하지 않는다. 이것은 다음 단계에서 완성할 것

이다. 

 

5.  배선 결과가 만족스러우면 PCB 설계를 완성하기 위해 Copper Pour기능을 사용한다. 이작업은 4개의 

power와 ground net에 연결을 할 것이다. 

 

주의 : Starpoint에서 나오는 두개의 connection은 부분 배선하여 Copper pour모양에서 작업을 마친다. 

 

각각의 power와 ground가 pour된 copper에 적당하게 연결되었는지 확인하기위해 배선을 수정하고 싶

으면, 간단하게 Copper Pour를 undo 하거나 Clear 기능을 사용한다. 

 

6. Embedded Place and Route를 빠져나가고 PCB 디자인을 저장한다. 

 

만약 디자인을 완성하지 못했으면 Rainmaker7_CS.pcb 파일을 연다. 

 



  

CADSTAR Ver 16          Do-It-Yourself Book CADSTAR Express  
  

 

(주) 디엠에스에스 68 www.dmsscadstar.co.kr  
 

 

 

배선과 배치후의 디자인B 

 

팁 : 만약 power와 ground 

핀에 여전히 Connection이 

보인다면, Copper에 배선

이 완료되었는지 확인하기 

위해 HTML Routing 

Completion Report를 생성

한다. 이것은 캐드스타창 

바닥에 나타난다. 다음 페

이지에 샘플이 있다. 직접 

실습한 내용과 다를 수 있

다. 내용을 확인하기 위해 

간단히 항목을 클릭한다. 

 

오른쪽 그림은 배선이 완료 

되지 않은 상태의 예이다. 

실습한 파일에는 남아있는 

Connection이 없을 수 있

다. 
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제 4단계 – 디자인 B의 제조에 팔요한 Data 

 

제조에 필요한 Data를 생성하기 위해 [Manufacture] 탭 -> Batch Process를 클릭하고 [Open]을 선택하여 

Manufacturing Output 2 Layer.ppf를 선택한다. 

 

여기에서 캐드스타 PCB Design 을 Board Modeler Lite 로 체크할 수 있다. Board Modeler Lite 는 STEPS 

AP203, AP214, ACIS STL 그리고 IDF 형식의 formats 을 Import/Export할 수 있으며 PCB 디자인의 3D 

상태에서 PCB 디자인의 배치와 검증을 위한 최적의 솔루션을 사용자에게 제공한다. 보드 외각을 교체하거나 

다른 PCB Design 또는 Housings 을 import 하고 부품 배치 정보가 자연스럽게 Back Annotate 된다. 이러한 

정보들을 모두 통합하여 3D를 만들고 완벽한 collision check 실행하여 몸체간의 충돌여부를 점검할 수 있다. 

 

 
 

캐드스타 3D는 단지 뷰어가 아니다 

아래를 클릭하면 더 많은 정보를 확인할 수 있다. 

www.zuken.com/cadstar-board-modeler-lite 



  

CADSTAR Ver 16          Do-It-Yourself Book CADSTAR Express  
  

 

(주) 디엠에스에스 70 www.dmsscadstar.co.kr  
 

 

●  제 3 장 – Library 

 

캐드스타 Library Editor 는 Symbol, Footprint, Part 정보를 관리하여 디자인의 상태를 유지할 수 있게 한다. 

Multiple library 도 지원한다. 

 

캐드스타 Express 에서 제공하는 library 는 이 “자습서” 에 나오는 PCB 디자인에 필요한 몇 개의 Part 와 on-

line CADSTAR Library 의 몇 개의 예만을 포함한다. Zuken Global support 를 이용하면 더 많은 Library 를 이용 

할 수 있다. On-Line 에서 제공되는 part 에는 생산자의 part number 를 포함하여 필요한 모든 정보가 들어있

다. 현재 250,000 개 이상의 part 가 제공되며 주기적으로 Update 된다. 만약 이 Library 에 필요한 Part 가 없

으면, Graphical Library Editor 와 마법사를 이용하여 원하는 Part 를 빠르고 쉽게 만들 수 있다. On-line 

CADSTAR Library 는 Maintenance 고객에게만 제공된다. 

 

 

 

Step 1 – PCB Component / BGA 마법사 

 

이 다음 단계를 위해, Graphical Library Editor를 이용할 것이다. 이것은 윈도 프로그램 메뉴나 Design Editor에

서 시작할 수 있다. 
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Library Editor는 캐드스타 프로그램의 일부이다. 이것은 PCB Components, Schematic symbols, Documentation 

Symbols 그리고 Parts를 편집하기 위한 multi-documentation interface를 사용한다. 

 

 

 

64 ball BGA 부품을 만들기 위해 BGA 생성 마법사로 시작한다. 

 

1. [Home] 탭에서 New 버튼을  

클릭한다. 그런다음  

[PCB Component] 탭을 클릭하고 

BGA Wizard를 선택한다.  

 

확인 버튼을 클릭한다. 
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2. {Component}Reference 

이름은 BGA-64로 입력한

다. Alternate 이름은 

Reflow로 입력한다.  

 

  단위를 Thousandths of an 

Inch 에서 Millimetres로 변

경한다.  

 

이것은 MM나 Thou로 표시

된 부품을 생성할 때 유용

하다. 

 

만약 부품 높이에 대한 

Design Rule Check를 하기 

원하면 Height를 입력한다. 

Design Editor 에서 

placement area에 지정된 

값으로 Check 하거나 Board Modeler Lite에서 collision check를 할 수 있다. 

 

이것은 새로운 부품이므로 version이 1이 될 것이다. 만약 [File] 탭 -> Options / System에서 

Automatic Version Increment가 허용되어 있으면, 앞으로 부품의 변경사항이 생기면 자동으로 Version 

이 증가한다. 사용자는 디자인에 사용된 부품이 Library에 등록되어 있는 최신 Version 인지 쉽게 확인 

할 수 있다. 

 

다음> 버튼을 선택한다. 

 

3.  Pad 와 Outline 에 사용될 Assignment 를 지정하는 것이다. 

 

Pads : 기 정의된 Pad Code bga64r 을 Pads 항목에 지정 한다.  

 

 Side : Top 면에서 보여지는 SMD 부품을 생성할 때는 Top 면에 SMD Pad 가 놓이게 반드시 Min 

side 를 선택한다. 

 

Origin : SMD 부품의 기준점은 centre 에 놓는다. 

 

Silkscreen Outlines : 여기서 지정된 Code 는 Silkscreen Outline 의 굵기를 나타낸다. Layer 는 Top 

silk 를 선택한다. 

 

Placement Outlines : 여기서 지정된 Code 는 Placement Outline 의 굵기를 나타낸다. Layer 는 Top 

Placement 를 선택한다. 

 

Assembly Outlines : 여기서 지정된 Code 는 Assembly Outline 의 굵기를 나타낸다. Layer 는 Top 

Assembly 를 선택한다. 

 



  

CADSTAR Ver 16          Do-It-Yourself Book CADSTAR Express  
  

 

(주) 디엠에스에스 73 www.dmsscadstar.co.kr  
 

 

참고 : 이러한 layer는 하위 유형으로 PCB layer 설정에서 참조하고 다른 기능에 의해 사용된다. 

 

 

 

다음> 버튼을 선택한다. 

 

4. 두 번째 단계는 부품의 Dimension을 입력한다.  

 

B 는 15 mm 

D 는 10 mm 

E 는 1 mm 

F 는 1 mm 

Nx 는 8 

Ny 는 8 

 

다음> 버튼을 선택

한다. 

 

 

 

 

 

 다음 다이알로그는 BGA Pads가 실제 component Package와 일치하도록 차감되는 Cative dimention

을 설계한다. 지금 만드는 부품은 이과정이 필요없기 때문에 건너 뛴다. 나중에 이 옵션을 사용해 보

자. 
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다음> 버튼을 선택한다. 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. 부품의 정확한 삽입을 

위해 Component

에 1 번핀 표시 위치를 

어떻게 할 지 결정한다. 

아래 그림과 같이 옵션

을 지정한다. 

 

 

 

다음> 버튼을 선택한다. 

 

 

 

 

 6.  마지막으로 BGA Pads에 Pin mame을 지정한다. 
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이 과정에서 마침 버튼을 누르면 마법사를 종료하고 bga64 가 생성되고 화면에 나타난다. 필요하면 

PCB 부품을 수동으로 수정할 수 있다. 

 

         

 

7. 작업이 완료되면, PCB 부품을 저장한다. [Librariy] 탭 -> PCB Components ->[Save Comp]를 클릭한

다.  

 

만약 같은 이름의 부품이 Library 에 이미 존재하면 overwrite 할 것인지 결정해야 한다.  
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Step 2 – Schematic Symbol / Block Wizard 

 

Schematic Block 생성 마법사를 시작한다. StrataFlashR Embedded Memory 디바이스를 생성한다. 이 디바이스

는 2 개의 Schematic Symbol 로 이루어 졌으므로 multiple gate 기능을 사용할 것이다. 

 

1. [File] 탭 -> New -> [Schematic Symbol]을 선택하고 Block Wizard를 선택한다. 

 

 

 

 Power Symbol과 Logic Symbol을 동시에 생성하는 것을 시작할 것이다. 

 

[확인] 버튼을 클릭한다. 

 

2. 사용자는 다른 template-file을 선택 

할 수 있다. 또한 Version 

Number도 지정 할 수 있다. ( 새

로운 Symbol이므로 1로 ) [Unit] 

는 작업하기 편하게 변경 할 수 

있다. 

 

다음> 버튼을 선택한다. 
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3.  두 번째 단계는 심볼의 Dimension 을 오른쪽 그림과 같이 입력한다. 

 

팁 : 디자인에 사용된 글자 폰트의 크기는 <ctrl>버튼을 누른 상태로 마우스 휠을 굴려 좀 더 보기 쉽

게 할 수 있다. 

 

 

 

 다음> 버튼을 선택한다.     

 

4.  다음 단계는 Gate 추가와 Pin의 개수와 Pin

의 위치지정 그리고 Reference Name을 추

가한다.  

 

Gate 추가 – 하나의 Gate를 추가한다.  

 

Gate A는 RC48F4400P0VT00-P의 

Reference Name과 Alternate Name POWER 

BLOCK을 입력한다.  

 

Gate B에 대하여 Reference Name 

RC48F4400P0VT00을 입력한다 

 

Number of Pins 는 59를 입력하고 Update 

버튼을 클릭한다. 

 

Pin Sequence Number 1에서 4를 CTRL키나 

SHIFT Key를 사용하여 선택한 오른쪽  

그림처럼다음 이들을 드래그하여 Gate A 의 Bottom아래에 놓는다. 
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다음으로 Pin Sequence Number 5에서 10을 CTRL 키나 SHIFT Key 를 사용하여 선택한 다음 이들을 

드래그하여 위의 그림처럼 Gate A의 Top 아래에 놓는다. 

 

팁 : Pin의 그룹을 선택하고 마우스 오른쪽 버튼을 클릭하여 나타나는 다이알로그를 클릭하여 사용할 

수도 있다. 

 

Pin Sequence Number 11에서 43을 CTRL 

키나 SHIFT Key 를 사용하여 선택한 다음 

이들을 드래그하여 위의 그림처럼 Gate B 

의 Left에 놓는다. 

 

이제 Pin Sequence Number 44에서 59를 

CTRL 키나 SHIFT Key 를 사용하여 선택

한 다음 이들을 드래그하여 Gate B의 

Right에 놓는다. 

 

 

 

 

 

 

 

 

 

 

 

spacer는 이전에 할당된 pin간격을 동일

하게한다. 

 

25번 핀 열을 클릭한 다음 [ADD] 버튼을 

클릭한여 25번 핀과 26번 핀 사이에 

spacer를 추가한다. 

 

 [Next>]를 선택한다. 

 

여기에서 만약 symbol Reference / Alternate 

이름이 이미 Symbol Library에 존재한다면 경

고창이 나타난다. 

 

이렇게하면 조치를 취할 수 있는 기회를 제공

한다. 

 

이 경우에는 [YES]를 선택한다. 
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5. 다음 단계는 Pin Name / Number 와 Pin Label의 기준점을 지정한다. 

  

Pin Name / Number와 Pin Label의 위치는 

최종 Pin 위치와 관련이 있다. 

 

주의 : 기본적으로 마법사는 Pin Name / 

Number는 Block의 바깥쪽에, 그리고 Pin 

Label은 안쪽에 지정한다. 

 

예와 같이 지정되었는지 확인한다. 

 

다음을 클릭한다. 

 

 

 

 

 

 

 

 

 

6.  마지막 단계는 Terminal과 Outline에 사용될 Assignment를 지정하는 것이다. 

 

Terminals : Terminal Code는 Terminal로 

지정한다. 

 

Outlines : 여기서 지정된 Code는 Outline 

의 굵기를 나타낸다. Symbol Outline을 선

택한다. 

                                                        

Origin : 심볼의 기준점은 terminal one에 

놓는다. 

 

 

이 과정에서 마침 버튼을 누른다.  

 

참고: Multiple Gate File을 지정하겠냐는 

물음에 No 를 선택한다. 이것은 오직 

Aldec FPGA pin list file  (CSV)을 읽을 

경우에만 필요하다. 

 

 

심볼이 생성되고 분리된 창에나타난다. 사용자가 원하면 수정하기위해 선택할 수 있다. 
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7. 사용자는 또한 Part Name의 기본 위치 같은 

Origon을 추가하기 위해 Add origin tool bar 아

이콘을 선택 할 수 있다. 

 

Origin type의 목록이 간단하게 나타나고 사용하

고 싶은 origin Name을 선택한다. 

 

두개의 심볼 모두에 (Part name), (Link) 그리고  

Description을 추가한다. 

 

 

 

 

 

 

 

 

 

8.  필요하면 Schematic 심볼을 수동으로 수정할 수 있다. 작업이 완료되면, Schematic 심볼을 저장한다. 

[Library] -> Schematic Symbols [Save Symbol] 버튼을 클릭한다.  

 

 만약 같은 이름의 심볼이 Library 에 이미 존재하면 overwrite 할 것인지 결정해야 한다. 
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이제 Schematic Block 생성 마법사를 다시 시작하고 다른 Device 를 만든다. 

 

심볼을 생성하는 또다른 방법은 처음부터 빈 화면을 열어 심볼을 만들 수 있는 Defauit를 선택하는 방법이다. 
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Step 3 - Parts Library Editor 

 

이제 생성된 PCB component 와 두 개의 Schematic 심볼을 연결시켜주는 Part를 생성할 수 있다. 

 

ⓐ  Library Editor에서 [File] 탭 -> Open을 클릭한다. Library 폴더로 이동하여 Parts.lib 를 연다. 팁: 아래 

그림과같이 파일 형식을 Parts Libraries로 변경한다. 

 

 

 

팁 : 표에 사용된 글자 폰트의 크기는 <ct기>버튼을 누르른 상태에서 마우스 휠을 굴려서 확대 축소하

여 좀더 읽기 쉽게 할 수 있다. 

 

2. [Home] 탭에서 줄을 추가하기 위해 New 아이콘을 클릭한다. 
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 Part Definition을 생성할 때 Part Name 과 Definition 항목은 반드시 입력해야 한다. (아래의 그림의  

 두 영역의 “Example”처럼 입력한다. )디자인에 사용된 부품의 Parts List 에 좀더 자세한 설명을  

         원한다면 Description 에 추가할 수 있다.           

          

 

3. [Parts]에서 [Definitions] Spreadsheet를 변경하기위해 Definition 탭을 클릭한다. 

 

 

 

여기에서 다음의 작업을 할 수 있다. 

 

♦ 브라우저를 열기위해 셀을 더블클릭하여 BGA-64(reflow)같은 Component모양을 선택한다. 

 

♦ 이름의 어근으로 사용하게될 “U”를 입력한다. 

 

♦ Attribute 정보를 입력한다. 

 

기본적으로 여러 개의 Parts 이름에 같은 Definition을 사용할 수 있으나 추후 Library 관리를 위해  

Part 하나당 하나의 Definition을 선택해도 된다. 
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4.  새로운 Part Definition “Example” 을 선택한다. Definition을 작성하기 위해 [Home] 탭을 클릭하고 

Edit에 있는 Part Definition 버튼을 클릭한다. 혹은 마우스 오른쪽 버튼을 사용할 수도 있다. 

 

 

 

5. Component 탭에서 Select를 클릭하고 이전 단계에서 BGA 마법사 기능을 사용하여 생성한 PCB 부품 

BGA64(Reflow)를 선택한다.  

 

Name Stem은 U로 지정한다. 

 

이것은 디자인에 Part가 추가될 때 부품이름의 어근으로 사용된다. 

 

 주의 : Component Name과 Name Stem은 두가지 모두 과정 3의 Definition 탭에서 입력해도 된다. 
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6.  Gate A와 B를 사용하기 위해 

Symbols 탭을 선택하고 

[Home] 탭에 있는 New 버튼

을 두 번 클릭한다. 

 

7.  Symbol Name 항목을 더블클

릭 하거나 마우스 오른쪽 버튼

을 이용하여 Select Symbol을 

선택한다. Gate A에 이전 단계

에서 Schematic Block 생성 마

법사를 이용하여 만든 Symbol 

RC48F4400P0VT00-

P(POWER-BLCK)을 선택한다. 

Gate B는 Symbol 

RC48F4400P0VT00을 선택한다. 

 

팁 : Symbol 이름을 입력하기 

시작하면 CADSTAR는 Symbol 

이름을 빠르게 찾아줄 것이다. 

         

8.  Pins 탭을 선택한다.  

 

여기에서 Component 

reference 모양 

BGA64(reflow)의 

Physical pin에 두 개의 

schematic gate의 핀을 

맵핑 한다. 

 

추가 적인 핀 정보 또한 

입력 할 수 있다. 

 

Pin 컬럼에 Component

의 Alpha-numeric Pin 

name의 목록이 나타나

는 것을 주지한다. 

이 이름들은 Schematic 

심볼 핀에 매핑되어 나타난다. 

 

Alpha-numeric Pin이름을 포함하는 Component reference 모양을 사용할 경우에 표에서 Pin Name을 

입력할 필요가 없다는 것도 주지한다. 
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9. [Home] 탭에 있는 Import Pin Labels를 클릭한다.  

 

각각의 Pin name에 대한 Pin label 대신  

c:\...\Zuken\CADSTAR Express 15.0\Self Teach에 제공되는 

Pinname list파일 import한다. 

 

pinlist.pin 파일을 선택하고 [OK] 를 클릭한다.   

 

참고 : pin list 는 부품 생산지의 website에서 내려 받기 하거나 MS 

Excel과 같은 spreadsheet 소프트웨어로 된 부품생산자 Datasheet 

에서 추출할 수 있다. 

 

 

 

 

 

만약 Pin list 가 Pin 탭에 있는 숫자보다 작으면 아래 그림처럼 경고표시가 나타난다. 

 

 

 

 Schematic Block 마법사를 이용하여 생성된 첫 번째 심볼 RC48F4400P0T00-P는 심볼의 Top과 

Bottom에 10 개의 Terminal이 있다. 이들은 왼쪽에서 오른쪽으로 번호가 지정되어 있다. 보통 VSS 

는 power 심볼의 아래 부분에 놓이고 VCC는 Top에 놓인다. 
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10. 다음 단계는 Pin Numbers / Names (그리고 Labels)에 심볼 Terminal을 지정한다.  

 

즉, Pin B2 (Label VSS) 에 Terminal A.1을 지정한다. 

= { Gate A. Symbol terminal 1 } 

 

 

 

 

Pin Name B2 (Label VSS) 열의 Terminal 셀을 선택하고 Assign Terminals나 마우스 오른쪽 버튼을 사

용하여 Assign Terminals 을 선택한다. 또는 셀을 더블클릭한다. 

 

 
 

 다음 Power Pin을 순서대로 선택하여 Power 심볼의 Mapping을 완성 할 수 있다. 

 

 Pin H2 (Label VSS)를 찾아서 Terminal 영역을 클릭한다. 자동으로 A.2가 할당되는 것을 볼 수 있다. 

 

 Terminal에 Pin label을 할당하면 미리보기 창에 Gate A 심볼이 나타날 것이다. 

 

 참고 : 만약 Terminal을 할당하는 동안 잘못 입력되면, Escape Key 를 누르고 정확한 위치에 새로운 

번호로 시작하면 된다. 
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다음과 같이 지정한다.  

 

pin/ball H4 (Label VSS) 에는 A.3  

pin H6 (Label VSS) 에는 A.4  

pin A4 (Label VPP) 에는 A.5  

pin A6 (Label VCC) 에는 A.6 

 pin H3 (Label VCC) 에는 A.7  

pin D5 (Label VCCQ) 에는 A.8 

 pin D6 (Label VCCQ) 에는 A.9  

pin G4 (Label VCCQ) 에는 A.10 

 

 

 

 

 

 

 

이제 Gate B (RC48F4400P0VT00)의 Terminal 을 할당한다. Pin A1 (Label A1)의 Terminal 영역을 클

릭하면 자동으로 B.1 (Gate B 의 Symbol Terminal 1)이 할당 될 것이다. 

 

Schematic Block 마법사를 이용하여 생성된 두 번째 심볼 RC48F4400P0T00는 심볼의 왼쪽과 오른쪽

에 49 개의 Terminal이 있다. 이들은 위에서 아래쪽으로 번호가 지정되어 있다. 

 

다음과 같이 Gate B 를 할당한다. 

 

pin A1 (A1) 에는 B.1   pin B4 (‘CE’) 에는 B.26 

pin B1 (A2) 에는 B.2   pin C6 (‘WP’) 에는 B.27 

pin C1 (A3) 에는 B.3   pin D4 (‘RST’) 에는 B.28 

pin D1 (A4) 에는 B.4   pin E6 (CLK) 에는 B.29 

pin D2 (A5) 에는 B.5   pin F6 (‘ADV’) 에는 B.30 

pin A2 (A6) 에는 B.6   pin F7 ( WAIT) 에는 B.31 

pin C2 (A7) 에는 B.7   pin F8 ( ‘OE’) 에는 B.32 

pin A3 (A8) 에는 B.8   pin G8 (‘WE’) 에는 B.33 

pin B3 (A9) 에는 B.9   pin F2 (DQ0) 에는 B.34 

pin C3 (A10) 에는 B.10   pin E2 (DQ1) 에는 B.35 

pin D3 (A11) 에는 B.11   pin G3 (DQ2) 에는 B.36 

pin C4 (A12) 에는 B.12   pin E4 (DQ3) 에는 B.37 

pin A5 (A13) 에는 B.13   pin E5 (DQ4) 에는 B.38 

pin B5 (A14) 에는 B.14   pin G5 (DQ5) 에는 B.39 

pin C5 (A15) 에는 B.15   pin G6 (DQ6) 에는 B.40 

pin D7 (A16) 에는 B.16   pin H7 (DQ7) 에는 B.41 

pin D8 (A17) 에는 B.17   pin E1 (DQ8) 에는 B.42 

pin A7 (A18) 에는 B.18   pin E3 (DQ9) 에는 B.43 

pin B7 (A19) 에는 B.19   pin F3 (DQ10) 에는 B.44 

pin C7 (A20) 에는 B.20   pin F4 (DQ11) 에는 B.45 
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pin C8 (A21) 에는 B.21   pin F5 (DQ12) 에는 B.46 

pin A8 (A22) 에는 B.22   pin H5 (DQ13) 에는 B.47 

pin G1 (A23) 에는 B.23   pin G7 (DQ14) 에는 B.48 

pin H8 (A24) 에는 B.24   pin E7 (Label DQ15) 에는 B.49 

pin B6 (A25) 에는 B.25 

 

11. 다음 컬럼 Type은 example part의 선택사항이다. 그러나 만약 사용자가 CADSTAR Signal Integrity 

Verification(SIV)나 Power Integrity Advance 어플리케이션을 사용한다면 적당한 Pin Type을 지정하는 

것이 필요하다. 

 

간단하게 셀을 더블클릭하면 사용가능한 Pin Type의 목록이 나타나므로 선택하기만 하면된다. 

 

 

 

12.  [Home] 탭을 선택한 다음 Gate + Pin Swapping 

탭을 선택한다. 

 

49 개의 Pin을 포함하는 External Swapping Group

을 확장하기 위해 클릭한다음 포함된 구성원들을 

확장한다. 

 

그림처럼 Label {A1} 에서 {A25}의 Pin 을 선택하

고 Equivalent Pins 버튼을 클릭하거나 마우스 오른

쪽 버튼 메뉴에서 Equivalent Pins를 선택한다.  

 

Label DQ0 에서 DQ15 까지, 같은 작업을 반복한

다. 이렇게 지정하면 Design Editor와 P.R.Editor 

XR 에서 배선을 최적화하는데 도움이 될 것이다. 
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13. [Attributes] 탭을 선택

하고 Manufacturers Part 

Number 의 Text 영역을 클릭한

다. RC48F4400P0VT00 을 추가

한다.  

 

원하면 더 많은 Attribute 를 지

정 할 수 있다. Attribute Value 

는 Design Editor 에서 값을 변

경할 수 없게 읽기전용으로 지정

할 수 있다.  

 

참고 : Attribute Names 버튼을 클릭하여 사용자 지정 Attribute 를 생성할 수 있다. 

 

Part 가 추가 되었으면 [File] 탭 -> Save 를 클릭하고 파일을 닫는다. 

 

만약 Error 나 Warning 이 발생했다면, ..\Zuken\CADATR Express 16.0\Library 폴더에서 Parts.lib 를 삭제한

다. 그런 다음 Parts_CS.lib를 Parts.lib 로 복사한다. 그리고 Libraries -> Parts 를 선택하고 [Parts Index] 를 

선택한다. Error 나 Warning 이 발생하지 않을 것이다. 

 

 

CADSTAR FPGA 

 

만약 위에서 설명된 대부분의 단계를 생략하기 원한다면 CSV (Aldec FPGA Data) 파일을 사용 할 수 있다. 

 

좀 더 자세히 알고 싶으면 Simulation, Synthesis, 배치와 배선 그리고 PCB 로의 핀 할당을 위한 모든 디자인파

일을 관리하는 하나의 프로젝트 메니저에서 Actel, Altera, Lattice, Quicklogic 그리고 Xilinx 를 지원하는 

CADSTAR FPGA 를 체크해 볼 수 있다. 

 

핀 동기화는 때때로 PCB 배선의 최적화와 거리가 멀 경우가 있다. 새로운 통합된 솔루션이 PCB board 와 

FPGA 디바이스 사이의 I/O 동기화를 지원한다. CADSTAR FPGA 는 PCB 배선을 최적화 하기 위하여 핀 할당 

변경내용이 Forward 와 Back-Annotate 를 지원한다. 

 

참고 : 동영상에는 bga363 Package 를 사용하지만 다음의 예에서는 bga64 Package 를 사용한다. 개념은 같

다! 

ㅡ 

Aldec 의 Active-HDL Lite 와 새로운 Zuken 의 CADSTAR 가 하나의 프로젝트 메니저에서 연결된 새로운 합작

품이다. 

 

만약 캐드스타 EXPRESS 사용도중 지원이 필요하면 ㈜대명시스템스 (Tel : 070-4640-2312) 으로 연락 한다. 

 

http://www.dmss.co.kr 
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●  제 4 장 - Design C (PREditor) 

 

많은 기능을 필요로 하는 복잡한 디자인을 작업하는 사용자를 위해 PREditor를 이용하여 Design C를 

생성하기로 한다. 하나의 환경에서 배치와 배선기능을 수행할 수 있는 PREditor에서 제공되는 더 많은 강력한 

기능을 이용해 배선과 배치를 빠르게 수행할 수 있다. Design A 와 Design B 의 배선을 위해 Embedded 

Router 에서 실행했던 모든 기능들을 Place & Route Editor XR 2000 에서도 실행할 수 있다. 

또한 이 디자인에서 Intelligent Bus 를 어떻게 생성하고 Signal Reference Links 를 어떻게 사용하는지 학습 학 

것이다. 

 

Step 1 - Design C 의 회로도 

 

1.      Design C는 거의 완성된 회로도 디자인을 이용한다. File / Open 을 선택해 제공된 DesignC_CS.scm  

파일을 열고 DesignC1.scm으로 저장한 다음 시작한다. 

 

CADSTAR 는 Intelligent Bus 를 생성 할 수 있다. 사용자는 Signal 이름으로 Bus 에 연결되는 Signal 

을 제한 할 수 있다. Bus에 대한 Item Properties에는 Bus에 연결되는 Connection 을 지정하는 

[Signal] 탭을 포함한다. 만약 Bus 를 제한 없이 지정하면 어떤 Net 나 연결 할 수 있다. 

 

Signal Reference Link 는 ( 계층 ) 디자인에 있는 같은 Net 의 다른 Signal Reference 로 건너뛰어 

찾아가서 보여주는데 사용한다. 

 

2.      [Home] 탭을 선택하고 Bus를 선택한다. Sheet 1 에 있는 U1, U2 그리고 

U3 에 Intelligent Address ( AD0-7 ) Bus 를 생성한다. 

 

Bus 의 시작점을 선택하고 Bus 를 그린다. 왼쪽 마우스 버튼을 클릭하여 

Corner 를 만든다. 왼쪽 마우스 버튼을 더블 클릭하여 완성한다. 

 

 

3.      Bus 이름과 Bus 에 Signal 이름을 추가하기 위해 Bus 를 선택  하고 Item Properties 창을 

클릭한다. Bus 이름을 AD[0-7] 이라고 지정한다. 
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이 작업은 버스에 대한 Item Properties 메뉴 다이알로그를 이용하여 수행 할 수도 있다. 선택된 버스 

위에서 마우스 오른쪽 버튼을 클릭하고 Item Properties를클릭한다. 

 

Signals 탭을 선택한다. Add 를 클릭하고 AD[0-7] 을 입력한 다음 OK 를 누른다. 

 

 

 

다이알로그를 빠져나가기 위해 [OK]를 클릭한다. 

 

이제 Bus 에 Connection 을 연결한다. 
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4.  U3-B 를 선택  하고 Move 아이콘  을 선택한 다음 Terminal 이 Bus 위에 놓일 때까지 

U3-B 을 Bus 쪽으로 이동한다. 왼쪽 마우스 버튼을 눌러 U3-B 를 내려놓으면 다음 창이 나타난다.  

 

다음과 같이 지정한다. :  

Start Signal Name: AD0 

Start Pin Position: 2 

End Pin Position: 9 

OK 를 누른다. 

 

U3-B 를 원래 위치로 복귀 시킨다. 

 

 U2-B 에 대하여 반복한다. 

 

U1-B 에 대하여 

 

Start Signal Name: AD0    Start Pin Position: 50  

End Pin Position: 57    Press OK 

 

 

 

팁 : [Net/Shape] 탭에 있는 Mitre 

Corner 기능을 사용하여 Bus의 

Orthogonal Corner에 Mitre를 

추가한다. 

 

 

  

팁 : Bus Terminal 은 신호의 흐름의방향에 맞추어 적당히 회전 할 수 있다. 회전하고자하는 모든 Bus 

Terminal을 선택하고 <Ctrl><L.M.B>방법을 사용한다. 선택한 후 <F3> rotate 명령어를 사용한다. 

 

5.  하나의 Connection을 Bus 에 연결하려면 Add Connection을 선택한다. 연결할 핀에서 시작한 다음 

Bus 까지 선을 그린다. 시스템은 어떤 Signal 이름을 추가할 것인지 물어볼 것이다. 
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Signal Refernece link 추가 

 

Signal Reference Link 는 디자인에서 

연결된 다른 Signal Reference 가 어디에 

있는지 보여주고 찾아가는데 사용한다. 

Link 의 Visibility 와 형식은 [Design] 탭 

-> Defaults 다이알로그 안의 [Link] 

탭에서 설정한다. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Zone 은 [Design] 탭 -> Zones 다이알로그에서 조정된다. 

 

Link 의 위치를 설정 

하기 위해 Zone 을 

사용 할 수 있다. 

Zone 은 Sheet 를 

가로와 세로로 

분리한다.  

 

6.  Sheet Form이 Euro 

Size이므로 단위를 

mm로 변경한다. 

 

7.  이 창을 오른쪽 그림과 

같이 지정한 다음 

[Apply to All 

Sheets]를 누른다. 

 

Display 영역에서 Left, 

Right, Top 그리고 

Bottom을 체크한다. 

 

8.  Reference를 Horizontal-vertical로 지정하고 [OK]를 누른다. 
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9. 이제 Sheet 의 왼쪽 아래 모퉁이에 있는 Signal Reference VCC 를 확인해 보자. 아래와 같이 

보여진다. 

 

 

 

 

 

예를 들어 1:6B 를 더블 클릭하거나 Signal Reference 를 

선택   한 다음 마우스 오른쪽 버튼을 누르고 Reference 

Link 중에서 하나를 선택하여 디자인에 연결된 여러 개의 

VCC Reference 를 찾아 갈 수 있다.  

 

10. DesignC3.SCM으로 회로도를 저장한다. 

 

만약 Signal Reference Link를 보고 싶지 않으면, 

DesignC3_CS.scm을 열고 DesignC3.scm으로 저장하여 

사용한다. 

 

11. [Design] -> Transfer to PCB 메뉴를 선택하여 회로도를 DesignC1.PCB로 변환하고 PCB technology 

영역에서 Eurocard-160x100.pcb 를 선택하고 OK 한다.  

 

만약 회로도 디자인을 전환하는 작업을 연습하고 싶지 않으면 2단계로 가기 전에 DesignC1_CS.pcb 

파일을 열고 DesignC1.PCB로 저장하여 사용하면 된다. 
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Step 2 - Design C 의 PCB 배치 

 

12. Design Editor 에서 부품을 수동으로 대충 배치한다.  

 

IC를 오른쪽 그림처럼 모두 

배치한다.  

 

SMD 부품은 Board 의 Top면이나 

Bottom면에 배치할 수 있다.  

 

모든 capacitor를 board의 

solder면에 배치한다. 즉, Move 

아이콘을 눌러 capacitor C1을 

이동한다. 이 때 마우스 오른쪽 

버튼을 눌러 나타난 메뉴 목록에서 

Mirror를 선택하고 적당한 위치에서 

클릭한다. 

 

참고 : Bottom 면에 배치된 부품은 색상을 통해 쉽게 확인할 수 있다.  

 

X1은 X 154.711 mm, Y 89.383 mm 위치에 90도 회전하여 배치한다. 

 

만약 이 과정을 완성하지 못했다면 DesignC2_CS.pcb 파일을 열고 DesignC2.pcb로 저장한 다음 

작업을 계속한다. 

 

팁 : 부품과 연결된 Net 를 하일라이트하여 보고싶으면 키보드에서 “T”<enter> 를 누르면 연결된 net 

가 하일라이트 지정 색깔로 토글된다. 

 

13. U1 과 U2 사이의 Connection 이 서로 꼬여 연결되어 

있다! 이것을 해결하기 위해 (부품의 특성이 Gate 와 Pin 

에 연결된 정보를 서로 변경하여 사용해도 된다면)  

[Component] 탭에서 Automatic Gate and Pin Swap 

버튼을 선택하고 다이알로그 상의 Start 버튼을 누른다.  

 

DesignC3.pcb로 회로도를 저장한다. 

 

참고 : Place & Route Editor XR 2000 에서는 배선을 

하면서 pin swap 을 할 수도 있다. 시도해 본다!  

 

CADSTAR 를 사용하여 회로도를 기준으로 설계하거나 

혹은 PCB 를 기준으로 설계할 수 있다. CADSTAR 는 

Full Back annotation 을 제공한다. 어느 것을 선택하든, 

PCB 디자인에서 Pin and Gate Swap, Component 

Rename, 부품, Connection 그리고 Attribute의 추가나 

수정 그리고 삭제와 같은 변경사항이 생기면 Back annotation 을 수행하는 것을 잊어서는 안 된다.  
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만약 Gate and Pin swap이 제대로 수행되지 않았다면 계속 진행하기 전에 DesignC3_CS.PCB 파일을 

열고 DesignC3.PCB로 저장하여 사용한다. 

 

 

14. Designc3.scm 회로도 디자인 파일을 열고 [Design] 탭에 있는 

Back Annotation 메뉴를 선택한다.  

 

Back Annotation 창에서 PCB 디자인 Design3c.pcb 파일을 

source 로 선택한다.  

 

만약 회로도에 없는 새로운 부품이 PCB 에 추가 되었다면, 이 

부품을 추가할 Sheet 를 선택할 수 있다. (여기서는 Sheet1 을 

선택한다.)  

 

Exclusion File 은 기구 홀이나 회로도에 나타나길 원하지 않는 

부품 같이 회로도에 존재하지 않는 부품들을 포함한다. 

Example3.cig 를 선택한다.  

 

이제 Back Annotation 을 수행하기 위해 OK 버튼을 선택한다. 

  

 

 

 

 

Step 3 - Design C 의 PCB 배선 

 

1.  Design3c.pcb 파일을 계속 사용하고 Tools / PREditor XR 을 선택하여 기본 Place & Route Editor XR 

로 이동한다. 

 

P.R.Editor 로 전환 될 때 RIF Export 옵션 창이 자동으로 

나타난다.  

 

Always Transfer Colours가 선택되었는지 확인한다. 

 

[OK] 를 선택한다. 
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 배치나 배선을 수행하기 전에 Configure / Routing Setup (또는 Ctrl+T) 다이알로그를 확인해야 한다.  

 

특히 Routing Option 은 배선을 진행하는데 중요한 변수로 작용한다. 왼쪽 예와 같이 설정한다.  

Copper 가 자동으로 Pour 되는 것을 원치 않으면 Auto Pour를 선택 해제 한다. 단위는 mm를 

사용한다. 

 

 

 

배선이 Push 되는 것을 원치 않으면 Pusher 를 선택 해제 한다. 
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P.R. Editor는 Design Editor로 되돌아가지 않고서도 부품배치를 변경 할 수 있다. 배치를 시작하기 전에 

Interactive Move 와 Push Aside 옵션을 check 하는 것이 좋다. 

 

2. 부품 배치 설정을 조정하기 위해 메뉴 바에서 Configure /  

Interactive Move 의 적당한 조정이 필요하다. 

 

배치 전 Placement Options 설정도 매우 중요하다 

 

3. 메뉴 바에서 Configure / Placement / Push Aside 를  

 선택한다. 아래의 예와 같은지 확인한다. 

 

 

 

4. 부품을 선택하고 Move  한다. 이 때 다른 부품 가까이로 근접시키면 기존의 부품이 밀리거나 

공간이 충분하다면 기존의 부품을 건너 뛰어 배치된다. 또한 부품을 보드의 다른 면으로 Swap  

하거나 Rotate  할 수 있다. 또한 이것은 오른쪽 마우스 버튼 메뉴를 사용하여 실행 할 수도 있다. 

 

지금 작업하고 있는 보드는 GND 와 VCC 2 개의 Power Plane 을 포함한 6 Layer 로 설정된 디자인 이다. 

 

5. 먼저 GND 와 VCC 신호에 대해 Stub routing 을 수행한다. Whole Net Mode  와 Auto route  

를 선택하고 GND 신호를 선택한다. (VCC 신호도 같은 방식으로 반복한다.)  

 

 

 

Place & Route Editor XR 에서는 Single net 나 Net 의 그룹 혹은 특정 영역에 대해 다양한 자동배선 

기술을 사용하므로 PCB 를 배선하는데 많은 도움이 될 것이다.  
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참고 : Function Key F5 와 F6을 사용하면 Layer 를 Top 에서 Bottom 이나 혹은 반대방향으로 스크롤 

할 수 있다. (시도해 보자) 

 

6. 다음은 BGA 부품에 Fan-out 을 생성한다. Fan-out 은 SMD 부품에 적용될 수 있는 배선 template 

이다. 이것은 가능하면 내층으로 배선하고 공간을 효율적으로 하는 형식을 사용하여 SMD Pad 에서 

breakout 형태로 배선을 한다. Fan-out 은 자주 사용되고 BGA, QFP 나 다른 디바이스에 쉽게 재사용 

될 수 있다. 

 

 

 참고 : 만약 Fan-out 툴 바가 보이지 않으면 View / Toolbars / Fan-out 을 선택한다. 

 

7. Fan-out 을 생성하기 전에 메뉴 바에서 Configure / Routing Setup 을 선택하고 Fan-out 탭을 

선택하여 아래의 예와 같이 지정되었는지 확인한다. 

 

 

 

8. Configure / Routing Setup ( Manual/Autorouting탭 ) 을 선택하고 Width 를 Necked 에서 Type 으로 

변경하고 값은 0.152 mm 로 지정한다. 

 

참고 : 만약 Place & Route Editor 창의 아래부분에 나타나 있는 단위가 Thou로 되어 있으면 Unit을 

더블클릭하여 소수점 3 자리를 사용하는 Millimeters로 변경한다. Routing Options 대화상자의 [Grids]탭에서 

Routing과 Via 그리드는 0.1 mm로 지정한다. 
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9. 메뉴 바에서 Routing / Fan-out /  

Perform Fanout 를 선택하고  

부품 U4 (BGA64) 주위를 드래그 하거나 Pad 몇 개만  

드래그한다. 

 

 

 

 

 

 

 

 

 

 

 

만약 배선이 나가는 방향을 Outward 에서 Inwards로 바꾸고 

싶으면, Configure -> Routing Setup [Fan-out] 탭을 선택하고 

Outward 에서 Inward 로 방향을 변경한다.  

 

메뉴에서 [OK] 버튼을 선택하고 이전의 Fan Out 작업을 Undo 

한다. 

 

메뉴 바에서 Routing / Fan-out / Create Outwards  (또는 Inwards) 를 선택하고 부품 U4 (BGA64) 

주위를 드래그 하거나 Pad 몇 개만 드래그한다. 이번에는 배선이 반대방향으로 생성된다. 

 

10. Fan-out 이 원하는 모양으로 생성되었으면 Routing / Fan-out / Save  ( Fan-out 툴바에 있다. )  

를 선택하고 생성된 Fan-out 주위를 드래그하여 저장 할 수 있다. 그래서 이것을 다른 디자인에  

재사용 할 수 있다. Footprint 를 ‘bga64.fpt’ 로 저장한다. 

부품 U4 부분을 확대하고 생성되어 있는 Fan-out 을 Unroute  한다.  

 

11. Configure -> Routing Setup 

[Fan-out] 탭을 선택하고 

Direction 을 File 로 

변경한다. File Browse 버튼을 

클릭하고 bga64.ftp 

파일을선택한다. 

 

Routing Setup 대화상자에 

있는 [OK] 버튼을 선택한다. 

 

이전의 Pan out 작업을 Undo 한다. 
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12. 메뉴 바에서 Routing / Fan-out / Create Outwards  (또는 Inwards) 를 선택하고 부품 U4 (BGA64) 

주위를 드래그 하거나 Pad 몇 개만 드래그한다. 이번에는 fan out file 에서 패턴이 형성 되었다. 

 

팁 : 디자인이 모두 “fan out” 처리 되면, 전체 디자인을 하나의 fan out file 로 저장 할 수 있다. 

각각의 부품에 대해 fan out pin 데이터가 저장될 것이다. 만약 다른 배치상태로 재배선이 필요하면, 

fan out 을 쉽게 재사용 할 수 있다. 

 

이제 다른 Direction 을 사용해보자 

 

13. Configure -> Routing Setup 

[Fan-out] 탭을 선택한다.  

 

그림과 같이 Direction을 [Exit] 

로 변경한다. 

  

Via Position을 Minimum Spacing 

로 변경한다. 

 

Via Name을 Circle 20/10(via)로 

지정한다. 

 

Layer Pair를 오른쪽 그린\a같이 

지정한다. 

 

 

 

14. Routing -> Fan-out -> Perform Fan out 을 선택하거나 Fan-out 툴바에 있는 아이콘  을 

선택하고 부품 U3 주위를 드래그한다. 

 

이 기능은 fan out 을 생성하는데 여러가지 pad 모양에 대해 기본적인 

pin exit direction 을 사용한다.  

 

이것은 전체 디자인에 있는 모든 SMD 부품에 대해 빠르고 쉽게 fan out 

을 생성하는데 사용된다. 

 

 

 

 

15. 다음 연습을 위해 작업중인 파일로 계속하거나 Design Editor에서 DesignC4_CS.pcb를 열고 

DesignC4.PCB로 저장한 다음 Tools / PREditor XR  을 선택하여 Place & Router Editor XR로 이동한다. 
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Place & Router Editor XR 은 뛰어난 자동배선 기술을 이용하여 단계별로 설계를 마칠 수 있게 도와줄 것 

이다. 예를들면 Trunk Routing 은 Data 와 Address Line 을 보다 쉽게 작업할 수 있게 도와줄 것이다. 

 

Trunk Routing 이란 무엇인가? 

 

Trunk Routing 은 가능한 한 최소의 노력과 직관적인 

방법으로 주어진 Signal 의 묶음을 한번에 배선할 수 

있는 Trunk object 라는 새로운 개념을 도입한 것이다. 

 

 

16. Trunk 배선이 될 connection의 선택 

 

 

Data 의 Bus 와 Address Line 은 이미 회로도 디자인에서 이미 

설계되었고 (Example3.scm 에서 했던) PCB 와 Place & Router 

Editor XR 로 변환되었다. 이름이 있는 Bus (Trunk) 는 Bus marker 

를 이용하여 선택 할 수 있다. 

 

 

 

 

 

Bus marker 부분을 확대한다. Manual Route  와 원으로된 marker 를 

선택한다. ( Shift + Click ) 작업을 시작할 것이다. 

 

Trunk 배선을 하는 다른 방법은 Manual Route   를 선택하기 전에 Bus 

marker 로 표시되어있는 Pad 들 중에서 하나를 더블 클릭 할 수 있다.  

 

참고 : Mark된 모든 Pad 들이 선택 되고 Highlight 된다. 

 

 

 

만약 회로도에서 Bus Signal이 지정되지 않았거나 Bus marker 가 보이지 않을 

경우에 Trunk배선을 시작하려면 Manual Route  를 선택하기 전에 Pad 여러 

개나 Connection 여러 개의 주위를 Multiple selection 으로 드래그 할 수 있다. 

 

 

 

17. Trunk 배선을 하기 전에 Trunking Options 을 check 할 것을 권한다. 메뉴 바에서 Configure / Routing 

Setup 메뉴 / Trunking 탭을 선택한다. 
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한 Layer 에 간단한 Trunk Manual 배선 

 

배선작업을 도와 주기 위해 snap axes 와 Trunk-end routing 영역이, Trunk 배선을 하는 Pin 의 Target 주위의 

화면에 그려진다. 각각의 배선 끝부분에 교차되는 Connection 을 최소화 하기 위해, target Pin 에 최적의 

각도를 보여주는 Twist Arrows 가 화면에 보여질 것이다. 또한 커서의 끝에 다이나믹하게 나타나는 Gather Point 

도 볼 수 있을 것이다. Gather Point 는 나란히 나타나는 배선의 모두를 하나의 Object 로 취급하게 되는 Trunk 

의 시작을 지정한다. 

 

18. Trunk 배선을 시작하려면 원하는 지점에 왼쪽마우스 버튼을 클릭하여 Gather Point 를 놓으면 된다. 

화면에 마우스를 이동하면 Trunk Segment 가 커서 위치를 따라 나타난다. 추가되는 Trunk Segment 

를 확인하기 위해 왼쪽 마우스 버튼을 사용한다. 왼쪽 마우스를 클릭한 다음에 다른 방향을 바꿔서 

커서를 움직이면 코너를 추가 할 수 있다. 

 

참고 : Trunk Routing 을 하는 동안 여러 가지 형태의 코너를 추가 할 수 있다. 이것은 오른쪽  

마우스를 눌러 나타나는 메뉴를 사용하여 바꿀 수 있다. 

 

원하는 Trunk 배선이 추가되면 여러 가지 방법으로 Trunk 배선을 끝낼 수 있다. 

►  마지막으로 추가된 코너 위치에서 Trunk 배선을 끝낼 때는 ‘Escape’ Key 나 오른쪽 마우스 

를 눌러 나타나는 메뉴 중에서 Cancel 옵션을 사용한다. 

►  Trunk Options 다이알로그에서 ‘Single Click Finish on Snap Line’ 옵션을 선택 하면 snap 

axis 위에서 한번만 클릭하여 Trunk 배선을 마칠 수도 있다. 메뉴 바에서 Configure / Routing 

Setup 메뉴 / Trunking 탭을 선택하는 것을 기억한다. 

 

기존에 추가된 Trunk에서 Trunk 배선을 다시 시작하는 것도 가능하다. 이것은 Manual Route 아이콘 

 을 선택한 후 화면에서 Trunk 를 선택 하거나 이미 선택된 Trunk 아이템을 Manual Route 아이콘 

 으로 선택하면 쉽게 할 수 있다. 
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참고 : ‘Backspace’ Key 또한 시도해 보자. (바로 이전의 배선 Segments를 제거하기 위해) 

 

Trunk 배선을 하는 동안 Trunk 그룹에서는 각각의 끝부분에서 교차되는 Connection 의 수를 최소화 

하기 위하여 다이나믹하게 재배열된다. 이것은 각각의 끝부분의 배선을 최적으로 할 수 있게 한다. 이 

옵션은 Trunking Options 다이알로그에서 Minimise Crossed Connection 셋팅을 사용하여 할 수 있다. 

 

19. Trunk 배선 도중 Via 추가하기 

 

Trunk Router 를 사용하는 도중 Trunk Via 패턴을 사용하려면 왼쪽 마우스 버튼을 더블클릭 하거나 

오른쪽 마우스 버튼을 눌러 나타나는 메뉴에서 Layer 옵션을 사용하여 다른 Layer 를 선택 한다. 또한 

Trunk 배선을 하는 도중에 오른쪽 마우스를 눌러 나타나는 메뉴를 사용하여 기 정의된 여러 가지의 

Trunk Via pattern style 을 변경하거나 ‘Tab’ Key 를 눌러서 기 정의된 Trunk 패턴 안에서 선택할 수 

있다. 

 

20. Trunk 와 Via 패턴의 수동 재배열 

 

Trunk 안의 단일 배선을 선택한 다음 Trunk 의 구성을 수동으로 재배열하는 것이 가능 하다. 배선을 

선택하기 위해 ‘Shift’ Key 를 누른 채로 왼쪽 마우스 버튼을 클릭한다. Trunk 안에 있는 배선 

세그먼트를 마우스 왼쪽 버튼을 누르고 드래그한다. 선택된 세스먼트를 움직임에 따라 어떻게 

나타나는지 살펴본다. ‘Tab’ Key 를 눌러 다른 항목을 선택하는 것도 가능하다. ‘Tab’ Key 를 누를 

때마다 커서 근처에있는 다음 세그먼트가 표시 된다. 이 트랙을 trunk 안에서 다른 위치로 드래그할 

수 있다. 

 

21. 수동 Trunk End Routing 

 

Trunk 끝 부분의 Connection을 인터랙티브하게 배선하기 위해 Manual과 Active-45 Router 를 사용 

할 수 있다. 필요하면 배선하는 도중 계속해서 trunk의 재배열을 할 수 있다. 

 

22. 자동 Trunk End Routing 

 

Trunk 배선을 하면서 

Trunk End router 를 

사용하여 Trunk 의 

끝부분을 자동으로 배선 할 

수 있다.  

Trunk End Routing target 

영역 안의 모든 trunk 

끝부분의 배선을 시작 한다. 

메뉴 바에서 Configure /  

Routing Setup / Trunking 

탭을 선택하고 아래 예와 

같이 셋팅 되었는지 

확인한다. 
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어떤 경우에는 디자인에 추가된 Trunk Object 를 분해하여 각각의 배선으로 바꿀 필요가 있다. 예를 

들면, Bus 의 Segment 를 배선으로 분리하여 다른 영역에 Bus 를 배선할 수 있다. 이렇게 하기 

위하여 먼저 분해하려는 trunk 아이템을 선택하는 것이 필요하다. 오른쪽 마우스 버튼을 눌러 

나타나는 메뉴에서 Decompose 옵션을 선택한다.  

 

참고 : Trunk가 배선으로 분해 되어도 이들 항목을 다시 묶어서 Trunk 로 되돌리는 것이 항상 

가능하지많은 않다. 만약 최서 이격거리를 위반하여 수정되었다면 

 

Trunk Routing, Manual 과 

Active-45 Router를 사용하여 

trunk 끝부분의 Connection을 

배선하고  

Board 를 완성한다. 

 

여기까지 완성하지 못했다면 

저장하지 말고 P.R.Editor XR 을 

빠져나가서 Design Editor로 

자동으로 돌아가면 

DesignC5_CS.pcb를 열고 

DesignC5.pcb로 저장한 다음 작업을 계속한다. 

 

23. Auto Routing 

 

다음 작업을 진행하기 위해 Design Editor 상에서 DesignC6_CS.pcb를 열고 DesignC6.pcb로 저장한 

다음Tools / PREditor XR 를 선택하여 P.R.Editor XR로 전환한다. 이 디자인은 배선이 되어있지 

않으며 자동배선을 하게 될 것이다. 

 

Auto Routing을 시작하기 전에 Routing Tool Options (CTRL+T)을 변경한다. Routing Tool Option을 

설정하는 것은 Routing 이 진행되기 전 중요한 변수로 작용된다. 메뉴 바에서 Configure /  

Routing Setup / General 탭을 선택한다. 다음의 예와 같이 지정되었는지 확인한다.  
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참고 : Error 를 허용했지만 Effort 10 값을 주어 어떤 errors도 남아있지 않을 때 까지 routing을 

계속하게 된다. 

24. 메뉴 바에서 Routing / Autoroute  를 선택하고 Board Outline 전체나 자동 배선을 하고 싶은  

 Board 의 일부분을 드래그한다. Auto Router 는 모든 Connection 이 배선되면 자동으로 멈출 것이다.  

 배선이 최적이지 못하므로 Refine Routing Pass 를 실행 할 수 있다. 

 

25. 메뉴 바에서 Routing / Refine Routing  를 선택하고 Board Outline 전체나 조정하고 싶은 Board  

 의 일부분을 드래그한다.  

 

참고 : Refine Pass 실행 후 Via와 Segments의 수가 감소한 것을 알 수 있다. 

 

26. 마지막으로 [Route] / Mitre를 선택하고 

Board 전체를 프레임으로 선택한다. 이 

작업은 90도 배선을 45도로 바꾼다. 

 

참고 : 45도 배선을 원차 않는 Layer를 

 보이지 않게 하여 Layer별도 Mitre 작업을 할 수 있다. 

 

만약 autorouting 과정을 완료하지 못했으면 저장하지 말고 Place & Route Editor XR을 빠져나가면 

자동으로 Design Editor로 되돌아 간다. DesignC7_CS.pcb 파일을 열어 DesignC7.PCB로 저장한 다음 

다음 단계 작업을 위해 P.R.Editor XR로 전환한다. 

 

27. In Circuit Test (ICT)를하기 위해 모든 Node에 Testpoint를 자동으로 생성 할 수 있다. (또는 가능한 한 

많이) Testpoint를 생성하기 전에 Configure / Routing Setup / Testpoints 탭을 선택하고 다음의 예와 

같이 지정되었는지 확인한다. Layers 옵션에서 ‘(Bottom Elec)’을 선택하는 것을 잊지 말자! 
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 위 그림에 지정된 내용은 Bottom Elec layer에 있는 모든 Net에 표면실장 Pad Circle 47을 사용하게 

된다. 연결된 동영상은 through hole via도 포함한 test point 사용법을 보여준다. 두 가지 방법을 모드 

시도해 보자! 

 

28. 이제 메뉴 바에서 Select / All 을 선택하여 메뉴를 선택하거나 <Ctrl+A> 를 사용할 수 있다. 디자인의 

모든 내용이 하일라이트 될 것이다. Routing / Testpoint / Allocate  를 선택하면 Testpoint 가 

자동으로 추가 될 것이다.  

 

29. 다음 예처럼 Testpoint Report 를 생성하기 위해 Utilities / Reports / Testpoints 를 선택한다. 
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이제 디자인이 완료 되었다. 메뉴 바에서 File / Exit 를 선택하고 결과를 생성한다. 만약 Testpoint 생성을 

완료하지 못했다면 완성된 결과를 보기위해 DesignC8_CS.pcb 파일을 열고 DesignC8.pcb로 저장한다. 

 

 

 

Step 4 - Design C 의 생산에 필요한 Data 

 

 

 

원한다면 이 디자인의 생산에 필요한 Data 를 생성 할 수 있다. [Manufacture] 탭 -> Batch Process 를 

선택한다. Batch Process 창 안에서 Open 을 선택하고 Self Teach 폴더에 있는 Manufacturing Output 6 

Layer.ppf  를 선택하고 START 한다. 

 

 

캐드스타 P.R.Editor XR 의 모델 별 기능 비교표를 보려면 아래를 클릭한다. 

 

Routing 비교표 
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 ●  제 5 장 - Design D (단면보드 설계) 

 

 

Transistor Audio Amp (50 mW) 

 

Design D의 정보 – Transistor Audio Amplifier 

 

Design D는 DesignB (little audio amplifier)와 같은 회로도를 사용한다. 단, 이번 경우에는 단면으로 설계하고, 

배선작업을 하면서 Jumper를 어떻게 추가하는지를 보여줄 것이다. Jumper는 두 개의 배선을 연결하는 

브리지로 사용된다. 여기에서의 Jumper는 non-functional jumper 이고 회로도에서는 나타나지 않는 경우로 

다뤄진다. 순서는 앞 예제와 동일하다. 

 

제 1 단계 – Design D 

 

1. DesignD_CS.scm을 열고 DesignD.scm으로 저장한 다음 Transfer to PCB 에서 PCB technology로 ‘1 

layer 1.6mm.pcb’ 를 선택하여 회로도를 PCB로 전환 시킨다. 이 default technology file은 기본으로 

제공되는 파일이며, 이 내용을 살펴보면 같은 라이브러리를 사용하더라도 Solder-pads가 더 커지고 

배선 굵기도 더 굵어지며 spacing 값도 더 크게 지정되어있음을 알 수 있을 것이다. 

 

제 2 단계 – Design D 의 PCB 배치 

 

이제 PCB로 전환된 부품을 배치할 수 있다. 다음에서 PCB 배치를 완성하기 위한 몇 가지 중요한 점들을 

얘기할 것이다. 만약 이 과정이 필요하지 않으면 제 2 단계 과정 7로 바로 가도 된다.  

 

단면 Board 설계에서는 Connection이 서로 교차되지 않게 잘 배치하는 것이 가장 중요하다. 그러므로 이 

과정에서 시간이 많이 소요된다. PREditor XR에서 Via를 추가하는 것처럼 Jumper를 추가할 수 있기 때문에 

걱정하지 않아도 된다. 

 

1. Unit 와 Grid를 확인하여 변경한다. (25 thou가 적당하다.) 
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2. Default Shape Type 을  로 변경한다. 

 

3. Board 외형을 그린다. (크기는 2000 x 1500 thou) 

 

4. Board 외형 주위에 부품을 분리 배치한다.  

 

5. 이름을 이용한 Itrm Properties 창을 이용하여 Board 안에 중요한 부품들은 수동으로 배치하고 

고정시킨다. 필요하면 회로도와 PCB를 동시에 띄워놓고 cross-prob 해본다. 

 

VCC는 X – 150, Y – 150에 배치한다. 

INPUTGND는 X – 150, Y – 1050에 배치한다. 

INPUT는 X – 150, Y – 1350에 배치한다. 

SPK는 X – 1850, Y – 1350에 배치한다. 

SPKGND는 X – 1850, Y – 1050에 배치한다. 

 

6. 다른 부품들은 자동배치 한다. 만약 배치를 못했다면 DesignD2_CS.pcb를 열고 DesignD2.pcb로 

저장하여 사용하면 된다. 

 

7. 배선작업을 하기 전에 [Design] 탭에서 Properties 다이알로그를 선택하고 [Design Options] 탭에서 

Jumper Support Enabled가 선택되었는지 확인한다. 
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8. 또한 배선작업을 하기 전에 Libraries -> PCB Components 를 확인한다. 만약 아래 그림처럼 PCB.LIB 

의 내용이 나타나 있다면 Jumper의 서브폴더를 볼 수 있을 것이다. PREditor XR에서 배선작업도중 

바로 선택하여 사용할 수 있도록 몇 개의 Jumper를 미리 생성해 놓았다. 

 

 

 

9. Example4b.pcb 를 열어 Tools -> PREditor XR 을 선택하여 PREditor로 이동한다. 

 

제 3 단계 – Design D의 배선 

 

PREditor XR로 변환 할 때 RIF Export Options 창이 

자동으로 나타난다. 여기에서 Write Jumpers from 

Library 가 체크되어 있는지 확인한다. 
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1. 배선작업을 시작하기 전에 Routing Setup 옵션을 확인하는 것을 권장한다. 배선을 하기 전에 Routing 

Option의 셋팅 상태는 매우 중요하다! 메뉴 바에서 Configure -> Routing Setup -> General 탭을 

선택한다. (또는 CTRL+T를 사용한다.) 셋팅 상태가 아래의 예와 같은지 확인한다. Copper가 자동으로 

Pour 되는 것을 원치 않으면 Auto Pour를 선택 해제한다. 또한 배선이 Push 되는 것을 원치 않으면 

Pusher 를 선택 해제하거나 Push 되는 배선의 수를 줄이고 싶으면 Effort의 수를 줄인다. 

 

 

 

2. 메뉴 바에서 Layer{current layer}를 선택하고 아래 그림처럼 Current Layer를 Bottom Elec으로 

변경한다. 

 

OK버튼을 클릭한다. 

 

 

 

참고 : 이 Technology 에서는 2 개의 layer 가 추가되었다! (Top Jumper 와 Bottom Jumper) 
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3. Item focus mode를 이용하여 resistor R2 와 capacitor C2 사이의 net를 그림에 보이는 것처럼 

Bottom Elec layer에 수동 배선 한다. 

 

           

 

다음 단계는 아래의 예에서 보이는 것처럼 resistor R2 와 transistor TR1 사이의 net를 Bottom Elec 

Layer에 수동배선  하면서 Jumper를 추가할 것이다.  

 

4.  Jumper의 첫 번째 Pad를 추가할 위치까지 배선을 하고 그 

자리에서 더블 클릭하여 Top Jumper를 선택한다. 그런 다음 

Jumper의 두 번째 Pad를 추가할 위치로 커서를 이동한다. 

PREditor XR은 화면에 기 정의된 Jumper의 Pitch를 나타내는 

가는 선을 표시할 것이다. 다시 더블 클릭하면 Jumper가 

추가되면서 배선작업을 계속할 수 있다. PREditor XR은 

라이브러리에 같은 Pitch로 정의된 Jumper가 하나이상 있을 

경우에만 기 정의된 Jumper 의 목록이 나타날 것이다. 이것은 Via를 추가하는 것과 같이 쉽다! 
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5. 이제 필요하면 Jumper를 추가하여 Bottom Elec Layer의 모든 connection을 배선한다. 

 

6. 설계를 마쳤으면 File -> Exit를 선택한다. 모든 배선과 Jumper가 PCB 디자인에 Back Annotate 된다. 

일반적으로 Jumper는 ECO Update 시에 없어지지 않으며 Parts List 와 Placement Data에는 

나타난다. 

 

 디자인을 완성하지 못했다면 DesignD3_CS.pcb를 열고 DesignD3.pcb로 저장한 다음 사용하면 된다. 

 

 
배치와 배선이 완료된 디자인 D3 – 실습내용은 다를 수 있다. 

 

제 4 단계 – Design D 의 생산에 필요한 Data 

 

이 단계에서는 디자인 A에서 했던 것처럼 PCB 제조에 

필요한 Gerber, N.C.Drill, Parts List, Placement Data 

등을 생성할 수 있다. [Manufacture] 탭 -> Batch 

Process 를 선택한다. Batch Process 창 안에서 Open 

을 선택하고 Self Teach 폴더에 있는 Manufacturing 

Output 2 Layer.ppf 를 선택하고 START 한다. 

 

출력하지 않을 열은 간단히 해제할 수 있다. 

이 디자인은 단면 PCB 이므로 Bottom Elec, Bottom 

Solder Mask, Top Silkscreen을 생성하면 된다. 

(모두 확장된 Gerber 형태인 S274-X format 을 

이용한다.) 이외에 Parts List, Placement Data 그리고 

Drill Data 등의 제조에 필요한 추가적인 Data를 

CADSTAR 에서 생성할 수 있다. 생성된 모든 Data는 Output 폴더에 저장된다. 
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혹시 ODB++ 형태의 출력 파일이 필요할 수도 있다. ODB++ 은 오늘날 가장 많이 사용되는 CAD / CAM data 

exchange 형식 중의 하나이다. 
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●  결론 

 

위의 4 가지 예제를 마치면 어느 정도의 PCB Design의 기초를 터득했다. 향후에 더 복잡한 PCB Design을 

캐드스타를 사용해 설계할 수 있을 것이다. 

 

이 설명서는 CADSTAR Express 와 같이 무상으로 제공된다. CADSTAR Express는 CADSTAR의 모든 기능이 

제공되며, 부품 50개 Pad 수 최대 300 Pin 까지 설계가 가능하다. 

 

가격이나 기타 기능 및 자세한 Demonstration을 원한다면 ㈜디엠에스에스에 문의를 하십시오. 

 

http://www.dmsscadstar.co.kr 

 

캐드스타에는 회로와 PCB Design을 설계하는데 도움을 줄 수 있는 추가적인 Tools 들이 다음과 같이 있다. 

 

http://www.zuken.com/cadstar 

 

 

 

 

 고맙습니다!  
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CADSTAR - 제품 구성 

모델 구성 추가 옵션 

Lite 2,000핀 제한, 4Layer 제한 

Basic 핀수 제한 없음, 6Layer 제한 

Professional 

핀수 제한 없음, Layer 제한 없음 

High Speed 설계 

길이를 고려한 배선 

Rulels By Area 

EMC Adviser 

Extreme 

핀수 제한 없음, Layer 제한 없음 

High Speed 설계 

길이를 고려한 배선 

Rulels By Area 

EMC Adviser 

Simulation 

Signal Integrity 

1.       CADSTAR 3D 

2.       Power Integrity 

  

 


